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 Copyright 

© 2025 Comet Technologies Canada Inc. All rights reserved. 

The present end-user documentation is confidential and proprietary information of Comet Technologies Canada Inc. (the 

“Company”). Only licensees of the Company have a right to use the information contained herein. Only licensees have 

the right to copy and/or transfer the information for internal use, unless otherwise agreed with the Company. Any 

unauthorized use, disclosure, transfer, or reproduction of this confidential information may give rise to a right in the 

Company to seek a legal remedy against such use, disclosure, transfer, or reproduction. 

Except as expressly provided otherwise in writing, the information provided in this document is provided AS IS, without 

any condition or warranty, whether written, oral, implied, legal, or statutory. The Company makes no warranty as to its 

accuracy. Any use of the documentation or the information contained herein is at the risk of the user. Documentation 

may include technical or other inaccuracies or typographical errors. Information is subject to change without notice. 

Trademarks 

Dragonfly, Dragonfly 3D World, and the Dragonfly logos are trademarks of Comet Technologies Canada Inc. 

Third-Party Trademarks 

Python is a trademark or registered trademark of the Python Software Foundation. Adobe, Acrobat, Flash, and Reader 

are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 

countries. Intel, Pentium, and Pentium 4 are registered trademarks or trademarks of Intel Corporation or its subsidiaries 

in the United States and other countries. NVIDIA and GeForce are registered trademarks or trademarks of NVIDIA 

Corporation in the United States and/or other countries. Microsoft and Windows are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or other countries. Advanced Micro Devices, AMD, and ATI 

are either registered trademarks or trademarks of Advanced Micro Devices Incorporated in the United States and/or 

other countries. VMware is a registered trademark and VMmark is a trademark of VMware, Inc. VMware VMmark is a 

product of VMware, an EMC Company. VMmark utilizes SPECjbb©2005 and SPECweb®2005, which are available from 

the Standard Performance Evaluation Corporation (SPEC). All other brand names, product names, or trademarks belong 

to their respective holders and should be noted as such. 

Notices 

Portions of Dragonfly’s 3D engine licensed from the University of Münster. 

Dragonfly is NOT a medical device. 

Cover Images 

Clockwise from the top left: Split view of segmented LED lightbulb (left) and 3D rendering (right): automated porosity 

segmentation of a casting: segmented curta mechanical pocket calculator (data acquired on a Comet Yxlon FF35 

system): and segmented battery cell. 
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1 New Features and Product Enhancements 

This software release for Dragonfly 3D World and Dragonfly 3D World ZEISS edition includes new features 

and performance enhancements that are sure to boost your productivity. Just a small sample of the 

highlights for version 2025.1 include: 

• The initial migration to PyTorch from TensorFlow for deep learning applications (see Migration to 

PyTorch from TensorFlow). 

• The incorporation of Meta AI’s Segment Anything Model (SAM), which offers a foundational model 

for image segmentation and is sure to reduce challenging and time-consuming labeling tasks (see 

Segment Anything Model (SAM)), as well as Cellpose-SAM for highly accurate and automated 

general-purpose segmentation of cells and cellular-like objects (see Cellpose-SAM). 

• Custom deep model architectures for image classification tasks (see Deep Model(s) for Image 

Classification) and an instance labeler to prepare training sets for classification (see Instance 

Labeler). 

• The implementation of a GPGPU (general-purpose computing on graphics processing units) 

framework, which provides significantly faster processing times for compute-intensive tasks such as 

image filtering, skeletonization, segmentation, and other complex operations (see GPGPU 

Acceleration). 

• Surface determination tool for generating perfectly accurate meshes (see Surface Determination 

Tool) and optimal meshes that provide a balance between complexity and a system’s capability to 

render meshes in 3D (see Optimal Meshes). 

• Processing of regions of interest and multi-ROIs in 2D (see 2D Processing of ROIs and Multi-ROIs). 

• A ‘Picture-in-Picture’ mode for 2D animations and screenshots in which an overlay of the 3D view 

can be added to any 2D view (see Picture-In-Picture Mode). 

• Volume sculpting, an effect splitter, optimized 3D settings, as well as brightness, contrast, and HSL 

controls to make your 3D renderings even more sensational. 
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2 Deep Learning 

This software release includes the migration to PyTorch from TensorFlow, the incorporation of Meta AI’s 

Segment Anything Model (SAM) for streamlining image labeling tasks, Cellpose-SAM for highly accurate and 

automated general-purpose segmentation of cells and cellular-like objects, custom deep model architectures 

for image classification tasks, the option to generate probabilities maps, easy sharing of trained deep models 

with other Dragonfly users, as well as other enhancements. 

2.1 Migration to PyTorch from TensorFlow 

To ensure that Dragonfly continues to offer state-of-the-art implementations for transformative image 

processing, this software release marks the migration to PyTorch from TensorFlow for deep learning 

applications. Although TensorFlow remains a powerful alternative for some applications, PyTorch’s 

community and research focus, along with its seamless integration within Python-based workflows and better 

memory management, makes it a more attractive choice for Dragonfly. Some noted advantages of adopting 

PyTorch include the following: 

• PyTorch is widely adopted in the research community and academia, with many innovative models 

and tools released in PyTorch first. 

• PyTorch benefits from rapid development and frequent updates that incorporate user feedback and 

features that enhance performance and usability. 

• PyTorch is widely adopted by industry leaders such as Apple, Meta AI, Open AI, Intel, and Amazon. 

• PyTorch offers better GPU memory allocation and management than TensorFlow. Unlike 

TensorFlow, PyTorch releases GPU memory at the end of training or inference and does not require 

users to close and restart Dragonfly to recover GPU memory. You should note that the preference 

for executing deep learning tasks in an external process were removed for this version of Dragonfly. 

• The TorchMetrics package from Lighting AI provides a collection of 100+ PyTorch metrics 

implementations for evaluating the performance of segmentation and regression models. 

• TensorFlow no longer provides native Windows support for GPUs as of version 2.10. 

You should be able to complete your deep learning workflows with PyTorch without any issues in this 

software release. Training, evaluation, and inference for new regression and semantic segmentation models 

are fully supported, including training parameters, model checkpoints, sparse labeling, class weights, and so 

on. currently available model architectures include Attention U-Net, Autoencoder, Sensor 3D, Trans U-Net , 

U-Net, U-Net 3D, U-Net SR, and U-Net++. Available custom architectures include Noise2Void for denoising 

and YOLOv7 for object detection, as well as EfficientNetV2 for training classification models. A selection of 

PyTorch versions of pre-trained models are also available for download. 

Transparent conversion of existing TensorFlow models to PyTorch for supported model architectures is 

selectable when Dragonfly 3D World 2025.1 is first launched. In some cases, you may note that the 

performance of converted Autoencoder, Sensor3D, and Trans U-Net models are not as good as the original 

TensorFlow versions. If this occurs, fine tuning converted models with data should resolve any noted issue. 

NOTE Contact us if you typically use a model architecture that is no longer available in version 2025.1 or if you 

experience any issues converting your existing TensorFlow models to PyTorch. 
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NOTE For users updating to version 2025.1, the Dragonfly Team recommends installing this version in a separate folder 

instead of overwriting a previous installation. This will let you continue using TensorFlow in cases in which the 

conversion of older models to PyTorch is not satisfactory. Installing this version in a separate folder is the default 

setting in the Dragonfly 3D World Setup Wizard, as shown below. 

 

2.2 Segment Anything Model (SAM) 

Labeling training sets for deep learning and machine learning, as well as for other purposes, can often be a 

challenging and time-consuming task. With the incorporation of Meta AI’s Segment Anything Model (SAM), 

Dragonfly 3D World now offers a foundational model for image segmentation, which ‘can cut out any object 

in any image, with a single click’ without the need for additional training. 

The Segment Anything Model (SAM) in Dragonfly 3D World lets you label images by generating 

segmentation masks for objects based on point and region prompts and then using those prompts to identify 

relevant object(s) and generate precise segmentations. As shown below, the Segment Anything tools can be 

used to quickly and accurately label nuclei, granules, mitochondria, pockets, and other components present 

within an image. 

 

Image partially segmented within minutes with the Segment Anything tools 
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The SAM painting tools are available on the ROI Painter panel in the main context and in the Segmentation 

Wizard, as shown and circled on the following screenshot. 

 

Segment Anything painting tools (circled) on the ROI Painter panel 

2.2.1 Downloading SAM for Online Systems 

You will first need to download the Segment Anything model before using the ROI Painter tools in Segment 

Anything mode for the first time. If your system is connected to the internet, simply click the Download 

Segment Anything button, as shown below, to automatically download and install the model to your local 

library. 

 

Download Segment Anything button on the ROI Painter panel 

2.2.2 Downloading and Installing SAM on Offline Systems 

You will first need to download and install the Segment Anything model before using the ROI Painter tools in 

Segment Anything mode for the first time. If your system is not connected to the internet, you will need to first 

download the .pth file that contains the serialized state of the SAM PyTorch model from our online 

downloads directory and then transfer and install the downloaded file on your offline system. 

Do the following to download and install SAM on an offline system: 

• Download the file ‘sam_vit_h4b8939.pth’ that is available at: 

https://downloads.theobjects.io/ai/segment_anything/sam_vit_h_4b8939/sam_vit_h_4b8939.pth 

• Transfer the file to a portable device, such as a USB key. 

https://downloads.theobjects.io/ai/segment_anything/sam_vit_h_4b8939/sam_vit_h_4b8939.pth
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• Create and then install the ‘sam_vit_h4b8939.pth’ file on your offline system in the directory: 

%localappdata%\Comet\Dragonfly2025.1\pythonUserExtensions\PythonPluginExtensions\ 

DeepTrainer\SegmentAnything\sam_vit_h_4b8939. 

 

2.2.3 Using the Segment Anything Point & Click Tools 

You can use the Point & Click and Point & Click Outline tools to provide a point prompt for the Segment 

Anything Model. The Segment Anything model will then identify and label the object(s) that are detected. 

1. Download the Segment Anything model, as described in Downloading . 

2. Select the region of interest or multi-ROI class which you plan to annotate. 

3. Select the 2D view on which you will paint. 

4. Select ‘Single slice’ in the 2D view tools box on the ROI Painter panel, if required. 

5. Do the following in the Segment Anything box: 

• Click the Load Model button if the Segment Anything model is not currently loaded. 

 

• Select the Point & Click or Point & Click Outline tool, as shown below. 

 

• Choose the dataset that will provide the input image in the Dataset drop-down menu, if 

required and as shown below. 
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6. Click the object that you want to segment in the 2D view, as shown below. 

 

The object is detected automatically and then labeled, as shown below. 

 

7. Label additional objects, as required. 

8. Unload the Segment Anything model when you have finished painting, as shown below. 
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2.2.4 Using the Segment Anything Region Tools 

You can use the Region tools to provide region prompts defined by rectangles, ellipses, polygons, and 

freehand areas for the Segment Anything Model. The Segment Anything model will then identify and label 

the object(s) detected within the region. 

1. Download the Segment Anything model, as described in Downloading . 

2. Select the region of interest or multi-ROI class which you plan to annotate. 

3. Select the 2D view on which you will paint. 

4. Select ‘Single slice’ in the 2D view tools box on the ROI Painter panel, if required. 

5. Do the following in the Segment Anything panel: 

• Click the Load Model button if the Segment Anything model is not currently loaded. 

 

• Select the required region tool, as shown below. 

 

• Choose the dataset that will provide the input image in the Dataset drop-down menu, as 

shown below. 
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6. Draw a region around the object that you want to label in the 2D view, as shown below. 

 

The object is detected automatically and then labeled, as shown below. 

 

7. Label additional objects, as required. 

8. Unload the Segment Anything model when you have finished painting, as shown below. 
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2.2.5 Configurable Actions for Segment Anything Painting Tools 

The following configured actions are available for working with Segment Anything’s Point & Click tools. 

Action Key Mouse 

Add to in Point & Click mode (in ROI Painter – SAM) Left Ctrl Left mouse 

Add to in Point & Click Outline mode (in ROI Painter – SAM) Left Ctrl Left mouse 

Remove from in Point & Click mode (in ROI Painter – SAM) Left Shift Left mouse 

Remove from in Point & Click Outline mode (in ROI Painter – SAM) Left Shift Left mouse 

Switch to add to in Point & Click mode (in ROI Painter – SAM) Left Ctrl  

Switch to add to in Point & Click Outline mode (in ROI Painter – SAM) Left Ctrl  

Switch to remove from in Point & Click mode (in ROI Painter – SAM) Left Shift  

Switch to remove from in Point & Click Outline mode (in ROI Painter – SAM) Left Shift  

Configurable actions for the Segment Anything Point & Click tools 

The following configured actions are available for working with Segment Anything’s Region tools 

Action Key Mouse 

Add to elliptical region (in ROI Painter – SAM) Left Ctrl Left mouse 

Add to freehand region (in ROI Painter – SAM) Left Ctrl Left mouse 

Add to polygonal region (in ROI Painter – SAM) Left Ctrl Left mouse 

Add to rectangular region (in ROI Painter – SAM) Left Ctrl Left mouse 

Remove from elliptical region (in ROI Painter – SAM) Left Shift Left mouse 

Remove from freehand region (in ROI Painter – SAM) Left Shift Left mouse 

Remove from polygonal region (in ROI Painter – SAM) Left Shift Left mouse 

Remove from rectangular region (in ROI Painter – SAM) Left Shift Left mouse 

Switch to add to in Ellipse mode (in ROI Painter – SAM) Left Ctrl  
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Action Key Mouse 

Switch to add to in Freehand mode (in ROI Painter – SAM) Left Ctrl  

Switch to add to in Polygon mode (in ROI Painter – SAM) Left Ctrl  

Switch to add to in Rectangle mode (in ROI Painter – SAM) Left Ctrl  

Switch to remove from in Ellipse mode (in ROI Painter – SAM) Left Shift  

Switch to remove from in Freehand mode (in ROI Painter – SAM) Left Shift  

Switch to remove from in Polygon mode (in ROI Painter – SAM) Left Shift  

Switch to remove from in Rectangle mode (in ROI Painter – SAM) Left Shift  

Configurable actions for the Segment Anything Region tools 

2.2.6 References 

SAM was trained on a diverse, high-quality dataset of over one billion masks, which enables it to generalize 

new types of objects — whether from computed tomography, cell microscopy, or other modalities — without 

requiring additional training. This ability to generalize means that users do not need to collect their own 

segmentation data and fine-tune a model for their use cases. Refer to the following for additional information 

about SAM: 

• Segment Anything website: https://segment-anything.com/. 

• Alexander Kirillov et al., 2023. Segment Anything, arXiv:2304.02643 

(https://arxiv.org/abs/2304.02643).  

https://segment-anything.com/
https://arxiv.org/abs/2304.02643
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2.3 Cellpose-SAM 

An important addition to Dragonfly 3D World’s segmentation pipeline, Cellpose-SAM provides highly 

accurate and automated general-purpose segmentation of cells and other similarly shaped objects, such as 

powders and aggregates. Cellpose-SAM uses the transformer backbone of Segment Anything’s foundational 

model to achieve superior generalization and accuracy without any additional training. This capability then 

lets you confidently measure characteristics such as area, perimeter, and circularity, and perform statistical 

analyses of size, morphology, number, and distribution. Unlike the original SAM, Cellpose-SAM doesn't 

require manual prompts for densely packed objects, making it more practical for common segmentation 

challenges. In addition, Cellpose-SAM is designed to be highly robust to variations in imaging conditions, as 

well as variations in sizes, noise, down sampling, and isotropic/anisotropic blur. 

You can run Cellpose-SAM in 2D, in which the image in the current 2D view will be segmented, or you can 

run Cellpose-SAM in 3D, in which case the whole input dataset will be segmented. Examples of the 

capabilities of Cellpose-SAM’s general-purpose segmentation are shown below. 

 

Input image (left) and resulting 2D segmentation (right) 

 

Input image (left) and resulting 3D segmentation (right) 
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NOTE You will need to download and install the Cellpose-SAM model before you can use it (see Downloading Cellpose-

SAM for Online Systems and Downloading and Installing Cellpose-SAM on Offline Systems). 

Do the following to run a Cellpose-SAM 2D segmentation in the current 2D view: 

• Select the 2D view in which you want to run the segmentation. 

• Right-click the required greyscale image or RGB image channels and then choose Cellpose-SAM 

2D (from Current View) in the pop-up menu. 

• Select the required settings in the Cellpose-SAM Parameters dialog (see Cellpose-SAM Parameters) 

and then click OK to initiate the segmentation of your data in the current 2D view. The result will be 

limited to the current slice.  

Do the following to run a Cellpose-SAM segmentation in 3D: 

• Right-click the required greyscale dataset and then choose Cellpose-SAM 3D in the pop-up menu. 

• Select the required settings in the Cellpose-SAM Parameters dialog (see Cellpose-SAM Parameters) 

and then click OK to initiate the segmentation of your data in 3D. The result will be fully segmented 

distinct objects that are within the selected thresholds.  

2.3.1 Cellpose-SAM Parameters 

The parameters you need to select for running a Cellpose-SAM segmentation are available in the Cellpose-

SAM Parameters dialog, shown below. In some cases, you may need to experiment with varying thresholds 

to achieve the best results. 

 

Cellpose-SAM Parameters dialog 

Parameter Description 

Flow Threshold 

Controls how strict object detection will be. 

Lower values (0.1 to 0.3)… Will find only the most certain objects. 

Higher values (0.5 to 1.0)… Will find more objects, including uncertain ones. 

In most cases, you should start with the default flow threshold of 0.4 and then adjust as 

follows: 

• Increase the value if objects that should have been segmented were omitted. 
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Parameter Description 

• Decrease the value if noise is detected. 

Object Probability Threshold 

Controls the size and number of detected objects. 

Lower values (0.0 to 0.2)… Larger and more objects will be detected. 

Higher values (0.3 to 1.0)… Smaller and fewer objects will be detected. 

In most cases, you should start with the default object probability threshold of 0.0 and 

then adjust as follows: 

• Decrease the value if only small objects are detected. 

• Increase the value if objects detected are too large or merged. 

Output as ROI 
If selected, the segmentation output will be a region of interest. If not selected, the 

output will be a multi-ROI.  

Cellpose-SAM parameters 

2.3.2 Downloading Cellpose-SAM for Online Systems 

You need to download the Cellpose-SAM model before using it for the first time. After the download is 

complete, the model will be installed automatically in your local library and the segmentation will run. 

Choose any of the Cellpose-SAM options in the dataset contextual menu and then click Yes in the Download 

Cellpose-SAM dialog, shown below, to automatically download and install the model in your local library. 

 

Download Cellpose-SAM dialog 

2.3.3 Downloading and Installing Cellpose-SAM on Offline Systems 

You need to download and install the Cellpose-SAM model before using it for the first time. If your system is 

not connected to the internet, you will need to download the ‘.cpsam’ file that contains the serialized state of 

the model from our online downloads directory and then transfer and install the downloaded file on your 

offline system. 

Choose any of the Cellpose-SAM options in the dataset contextual menu. The instructions for downloading 

and installing Cellpose-SAM on your system appear in Download Cellpose-SAM dialog, as shown below. 
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Download Cellpose-SAM dialog 

Do the following to download and install Cellpose-SAM on an offline system: 

• Download the file ‘cpsam’ that is available at: https://downloads.theobjects.io/ai/misc_model/cpsam 

• Transfer the file to a portable device, such as a USB key. 

• Create and then install the ‘cpsam’ file on your offline system in the directory: 

%localappdata%\Comet\Dragonfly2025.1\pythonUserExtensions\PythonPluginExtensions\ 

DeepTrainer\Cellpose-SAM\models. 

2.3.4 Reference 

Marius Pachitariu, Michael Rariden, and Carsen Stringer, 2025. Cellpose-SAM: superhuman generalization 

for cellular segmentation. bioRxiv 2025.04.28.651001 (https://doi.org/10.1101/2025.04.28.651001). 

2.3.5 Copyright Notice 

Copyright © 2020 Howard Hughes Medical Institute 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that 

the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the following 

disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of HHMI nor the names of its contributors may be used to endorse or promote products 

derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND 

ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 

WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 

DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR 

ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 

OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 

THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 

IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  

https://downloads.theobjects.io/ai/misc_model/cpsam
https://www.biorxiv.org/content/10.1101/2025.04.28.651001v1
https://www.biorxiv.org/content/10.1101/2025.04.28.651001v1
https://www.biorxiv.org/content/10.1101/2025.04.28.651001v1
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2.4 Ready-to-Use Deep Models 

A new ready-to-use deep model for segmenting porosity in castings is now available for download. Inference 

includes shrinkage pores and features that can often be missed by regular thresholding due to a lack of 

contrast or resolution. Training was performed on a dataset with sequential training steps with an increasing 

number of frames and varying patch sizes and data augmentation.  

An example of the inference of the ready-to-use basic casting porosity model is shown below. 

 

Inference of basic casting porosity model 

The ‘Basic Casting Porosity’ model features a U-Net architecture with a depth level of 7, an initial filter count 

of 32, and an input dimension of 2.5D. Input images should be calibrated with century units (CU) so that the 

background voxels are 0 and the material is 100. 

The model is available in the Remote Library of Ready-to-Use Regression and Segmentation Models dialog, 

as shown in the following screenshot. Click the Import Remote button in the Deep Learning Tool, or the 

Open Remote Library icon on the Segment with AI panel, to open the dialog. 
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Remote Library of Ready-to-Use Segmentation Models dialog 

2.5 Custom Deep Model Architectures 

This software release includes new models for image classification, as well as updates for 3D World’s deep 

model architectures for denoising (Noise2Void) and for object detection (YOLOv7). 

Choose Artificial Intelligence > Custom Deep Model Architectures to access these new and updated 

model architectures. 

 

Custom Deep Model Architectures menu items 
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2.5.1 Deep Model(s) for Image Classification 

This software release provides the custom deep model architectures EfficientNet for unparalleled efficiency 

and accuracy for image classification tasks.  

Choose Artificial Intelligence > Custom Deep Model Architectures > Classification on the menu bar to 

open the Classification dialog, shown below. 

   

Classification dialog 

You can generate new models and set the training parameters on the Train tab’s Models, Inputs, and 

Training Parameters tabs, while you can apply trained classification models on the Apply tab. Typical 

inputs for classification are image data and a multi-ROI with a scalar values slot that classifies the labeled 

objects in the multi-ROI. Typical outputs for classification models are multi-ROIs with defined classes for the 

segmented objects. You should note that the task of classifying instances in multi-ROIs can be accelerated 

with 3D World’s Instance Labeler tool (see Instance Labeler). 
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Click the New button to open the Model Information dialog, shown below. You can choose class and input 

counts, model types, model parameters, and other settings in the dialog. 

 

Model Information dialog 

References 

EfficientNetV2: 

https://docs.pytorch.org/vision/main/models/efficientnetv2.html 

https://arxiv.org/abs/2104.00298 

Architectures comparison table: 

https://docs.pytorch.org/vision/main/models.html#table-of-all-available-classification-weights 

  

https://docs.pytorch.org/vision/main/models/efficientnetv2.html
https://arxiv.org/abs/2104.00298
https://docs.pytorch.org/vision/main/models.html#table-of-all-available-classification-weights
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2.5.2 Noise2Void for Denoising 

As an alternative to classic deep models for denoising, such as noise-to-low noise and noise-to-noise, 

Dragonfly 3D World also provides an approach known as Noise2Void in which training is done directly on the 

data to be denoised. Updates in version 2025.1 for training Noise2Void denoising models include advanced 

settings for configuring early stopping and learning rate parameters. These options are available on the 

Training Parameters tab. 

Choose Artificial Intelligence > Custom Deep Model Architectures > Noise2Void on the menu bar to 

open the Noise2Void dialog, shown below. 

 

Noise2Void dialog 
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2.5.3 YOLO (You Only Look Once) for Object Detection 

This software release provides an update for the previously available YOLO (You Only Look Once) custom 

deep model architecture for object detection. Now updated to YOLOv7, this powerful object detection model 

can be trained to predict bounding boxes around detected objects that indicate their location. 

Choose Artificial Intelligence > Custom Deep Model Architectures > YOLOv7 on the menu bar to open 

the YOLOv7 dialog, shown below. 

 

YOLOv7 dialog 

NOTE For best results, the slice size of your training set should be equal to the selected patch size. If required, you can 

add padding to the training set to match the available patch sizes or crop the input(s) to the available patch sizes. 

In addition, disabling data augmentation may also result in improved performance. 

Reference 

Chien-Yao Wang et al., 2022. YOLOv7: Trainable bag-of-freebies sets new state-of-the-art for real-time 

object detectors, arXiv 2207.02696 (https://doi.org/10.48550/arXiv.2207.02696).  

https://arxiv.org/abs/2207.02696
https://arxiv.org/abs/2207.02696
https://doi.org/10.48550/arXiv.2207.02696
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2.6 Probabilities Outputs 

Probability can play a crucial role in deep learning by helping to quantify uncertainty in model predictions. 

This can be especially important in cases in which understanding the probabilities and/or confidence of a 

model’s predictions can significantly impact decision making. As shown in the following example, 

probabilities and confidence maps are available for each output multi-ROI class, such as the membranes of 

a neural tissue training set. 

 

Detail of the inference of a membrane segmentation (left) and the corresponding probabilities map (center) and 

confidence map (right) for the inference 

The options to generate probabilities and confidence maps as the inferred output of a trained segmentation 

model are available on the Segment with AI panel as shown below. You can choose to compute maps for 

the full dataset, marked slices, or within a mask. 

 

Segment with AI panel 

NOTE Probabilities maps for all classes are output as time-enabled images in which the probabilities of each class will 

appear on different time steps. If your output multi-ROI has 5 classes, then the map will have 5 time steps. 
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2.7 Deep Learning Tool UI Changes 

The migration to PyTorch, as well as the option to share deep models, has necessitated minor changes to 

the options available in the Deep Learning Tool dialog, shown and described below. 

 

Deep Learning Tool dialog 

The following changes were implemented in the Deep Learning Tool dialog for this software release. 

Import Keras… As part of the migration to PyTorch from TensorFlow, the option to import Keras models into 

the Deep Learning Tool was removed. 

Share… This added item lets you share trained deep models with other Dragonfly users on the Dragonfly 

Social platform (see Sharing Deep Models). 

Go to Editing… The Model Editing panel, which was used to edit network structures defined in the Keras 

API, is no longer available in Dragonfly 3D World as of version 2025.1.  
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2.8 Sharing Deep Models 

This software release provides the option to share trained deep models with other Dragonfly users on the 

Dragonfly Social platform. Click the Share button on the Deep Learning Tool dialog, as shown below, to 

open the Share AI Model to Dragonfly Social dialog. 

 

Deep Learning Tool dialog 

You can edit the general documentation in the Share AI Model to Dragonfly Social dialog, if required. Shared 

models are saved in compressed ZIP files and then posted on Dragonfly Social in the AI Models section. 

Postings automatically include a screenshot of the current view of the Dragonfly workspace. 

 

 

Share AI Model to Dragonfly Social dialog (left) and posting on Dragonfly Social (right)  
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2.9 Anatomical Structures Segmentation 

This software release includes a beta implementation of TotalSegmentator, a deep learning model 

designed for the automatic and robust segmentation of anatomical structures in both CT and MRI images. 

Introduced by Wasserthal et al., TotalSegmentator is capable of automatically segmenting up to 117 distinct 

anatomical structures, such as organs, bones, muscles, and vessels, making it a valuable tool for various 

applications. Thanks to training on a large and diverse dataset of CT volumetric scans collected 

longitudinally from routine examinations, TotalSegmentator is able to generalize well to different imaging 

protocols, body parts, and patient demographics. Implemented with the nnU-Net architecture, 

TotalSegmentator can achieve impressive accuracy exceeding 90% on test datasets, with both the model 

and training data publicly accessible for academic research. 

Building upon this foundation, Häntze et al. more recently developed MRSegmentator to address the unique 

challenges of segmenting MRI images. MRSegmentator was trained on a heterogeneous dataset comprising 

1200 manually annotated MRI scans from the UK Biobank, in-house MRI scans, and 1228 CT scans. While 

also utilizing the nnU-Net architecture, MRSegmentator demonstrates particular robustness in segmenting 

anatomically variable structures such as the liver and kidneys. 

NOTE The TotalSegmentator and MRSegmentator are not medical devices and are not intended for use in the diagnosis 

or classification of any medical complaint or for any other medical use. The Anatomical Structures Segmentation 

plugin is for research purposes only and is provided ‘as is’ without warranty of any kind. 

An example of the automated segmentation capabilities of TotalSegmentator is shown below. Typical inputs 

are 3D DICOM images or other datasets that accurately represent the size and shape of human anatomical 

structures and that were acquired with computed tomograph (CT) or magnetic resonance image (MRI) 

systems. The output of TotalSegmentator is a multi-ROI in which each anatomical structure is represented 

as a distinct class. 

 

Segmentation of CT data with TotalSegmentator 

https://github.com/MIC-DKFZ/nnUNet
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Right-click the required CT or MRI image and then choose Anatomical Structures Segmentation in the 

pop-up menu to open the Anatomical Structures Segmentation dialog.  

As shown in the following screen, you can choose the TotalSegmentator segmentation model for computed 

tomograph (CT) acquisitions, as well as the tissue types that you need to segment. For magnetic resonance 

imaging (MRI) acquisitions, you need to choose the MRSegmentator as the segmentation model. In either 

case, you also need to select the patient position — supine or prone — before you run the segmentation. 

 

Anatomical Structures Segmentation dialog 

2.9.1 References 

Wasserthal et al., 2023. TotalSegmentator: Robust Segmentation of 104 Anatomic Structures in CT Images. 

Radiology: Artificial Intelligence (https://doi.org/10.1148/ryai.230024). 

Isensee et al., 2021. nnU-Net: a self-configuring method for deep learning-based biomedical image 

segmentation. Nature methods, 18(2), 203-211. 

Häntze et al., 2024. MRSegmentator: Multi-Modality Segmentation of 40 Classes in MRI and CT. 

arXiv:2405.06463. 

  

https://pubs.rsna.org/doi/10.1148/ryai.230024
https://pubs.rsna.org/doi/10.1148/ryai.230024
https://www.nature.com/articles/s41592-020-01008-z
https://www.nature.com/articles/s41592-020-01008-z
https://arxiv.org/abs/2405.06463
https://arxiv.org/abs/2405.06463
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2.10 AI Visual Assistant 

This software release includes an initial implementation for Dragonfly 3D World’s AI Visual Assistant. The 

AI Visual Assistant lets you enter prompts to identify key elements and extract visual insights from 2D 

images in the form of text, points, or multi-ROIs. 

Choose Artificial Intelligence > AI Visual Assistant on the menu bar to open the AI Visual Assistant panel. 

The AI Visual Assistant, shown below, will appear on the left sidebar by default. 

 

AI Visual Assistant dialog 

You must select a 2D view as well as an image in the Data Properties and Settings panel to activate the 

Generate button. You can select multiple outputs, such as text and multi-ROIs. Output multi-ROIs consist of 

single labeled voxels placed in the center of each identified object.  

NOTE You will need to download and install the Molmo model before you first use the AI Visual Assistant. You should 

also note that the model requires 32GB of free disk space, as shown below. Model weights, datasets, and source 

code are available at https://molmo.allenai.org/blog. 

 
The model will be saved in %AppData%\Local\comet\Dragonfly2025.1\pythonUserExtensions\ 

PythonPluginExtensions\DeepTrainer. 

2.10.1 References 

Matt Deitke et al., 2024. Molmo and PixMo: Open Weights and Open Data for State-of-the-Art Vision-

Language Models. arXiv:2409.17146. 

https://molmo.allenai.org/blog
https://arxiv.org/abs/2409.17146
https://arxiv.org/abs/2409.17146
https://arxiv.org/html/2409.17146v2
https://arxiv.org/html/2409.17146v2
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2.11 Deep Learning Requirements for 2025.1 

Deep learning in Dragonfly 3D World requires a dedicated NVIDIA graphics card with CUDA or an Intel 

integrated graphics processor (IGP) with UHD Graphics.  

You should note that the installer for version 2025.1 includes two compiled versions of PyTorch — 

‘pytorch_118’ for CUDA version 11.8 and ‘pytorch_128’ for version 12.8 and later. The appropriate version 

will be installed automatically on your system, which should be sufficient in most cases. However, if you want 

to run PyTorch with the latest CUDA version, you should update your installed graphics driver (if required) 

before installing Dragonfly 3D World 2025.1. CUDA version 12.8 is available in NVIDIA graphics drivers 

starting at version 570. 

There are multiple ways to check the NVIDIA graphics driver and CUDA versions that are installed on your 

PC. The easiest method is by opening the NVIDIA Control Panel as follows: 

• Right-click on your desktop. 

• Choose NVIDIA Control Panel in the pop-up menu, as shown below. 

 

The version number of the installed NVIDIA graphics driver is listed the NVIDIA Control Panel dialog, 

as circled below. 

 

CUDA version 12.8.0 is available in NVIDIA graphics drivers starting at version 570. 

• To check the installed version of CUDA, click the ‘System Information’ link on the bottom left corner 

of the NVIDIA Control Panel dialog to open the System Information dialog.  
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• Click the ‘Components’ tab to view the component information about your NVIDIA graphics card. 

The installed version of CUDA will be listed in the dialog as shown below. 
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3 Segmentation Wizard 

Training settings, custom class weights, and saving frames are available in this software release for 

Dragonfly’s Segmentation Wizard. The Segmentation Wizard provides an easy-to-use, guided workflow for 

training deep models and machine learning models for image segmentation. 

3.1 Training Settings 

This software release includes the option to set the batch size for training deep models and to evaluate the 

estimated memory ratio. These updates are available in the Training Parameters dialog, as shown below. 

Right-click a deep model on the Models tab and then choose Update Training Parameters in the pop-up 

menu to open the dialog. 

 

Settings tab in the Training Parameters dialog 

3.1.1 Batch Size 

During deep model training, patches are randomly processed in batches and the number of patches in a 

batch is set with the ‘batch size’ parameter. You can now choose from the following options to set this 

parameter: 

Auto-set… If selected, the batch size will be set automatically based on the available GPU memory and the 

selected model. 

Custom… Lets you manually select a batch size. You should monitor the estimated memory ratio whenever 

you set this parameter yourself. 
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3.1.2 Estimated Memory Ratio 

The estimated memory ratio is calculated as the ratio of the estimated memory needed to train the model at 

the current settings over the available GPU memory. This ratio is shown whenever ‘Custom’ is selected as 

the ‘Batch size’ setting. You should note that the memory needed to train a deep model is dependent on the 

depth of the model, the selected patch and batch sizes, the optimization algorithm, and other settings. 

Green… The estimated memory requirements are within your system’s capabilities, typically within the range 

of less than 0.90. 

Yellow… The estimated memory requirements are approaching your system’s capabilities. Ratios between 

0.90 and 1.00 may or may not result in successful training. You can adjust the patch and/or batch size to 

reduce the estimated memory requirements. 

Red… The estimated memory requirements exceed your system’s capabilities. You should consider 

adjusting the model training parameters, such as the patch size, or selecting a shallower model. Training 

often fails when ratios are greater than 1.0. 

3.2 Custom Class Weights 

Previously available only in the Deep Learning Tool, you can now set custom class weights in the 

Segmentation Wizard to solve class imbalance problems and to accelerate training. This option is available 

on the Models tab in the Class weights drop-down menu, as shown below on the left. You can set the 

custom class weights in the Class Weights dialog, shown below on the right. Click the ‘More’ button to open 

the dialog. 

   

Class weights options (left) and Class Weights dialog (right) 

NOTE You can increase the weight for a class if only a few labels are available, and conversely, you can decrease the 

weight for background and/or unimportant features. 
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3.3 Saving Frames 

In previous Dragonfly 3D World versions, you could only export all segmented frames as a multi-ROI to the 

main context. As of version 2025.1, you can save all segmented frames directly to a local or remote drive. 

The option to save to disk is available in the Export sub-menu, as shown below. 

 

Save to Disk option for frames 

  



 

 

 

    

Release Notes 

 

Dragonfly 3D World, Version 2025.1 
2025-09-11 

 Page 40 of 137 

    

4 GPGPU Acceleration 

Thanks to the implementation of a GPGPU (general-purpose computing on graphics processing units) 

framework, this software release provides significantly faster processing times for image filtering, 

skeletonization, segmentation, mesh generation, and other compute-intensive tasks. Supported hardware on 

Windows and Linux includes AMD and NVIDIA GPUs, as well as Intel ARC GPUs and Intel integrated 

graphics UHD that support OpenGL 4.3 and up. 

In most cases, GPGPU acceleration out performs CPU-based image processing by leveraging the parallel 

processing power of GPUs. GPUs have thousands of small processing cores that can execute the same 

instruction on multiple pixels simultaneously, which makes them highly efficient, especially for large images 

or complex algorithms.  

As shown in the graph below, processing times on AMD and NVIDIA GPUs, as well as on Intel integrated 

graphics UHD, can experience multiple orders of magnitude improvement in performance compared to 

processing on CPU while maintaining accuracy and precision. 

 

Comparative benchmark of GPU versus CPU processing of a USHORT 1024×1024×1024 dataset 

NOTE Not all GPUs are equally suited for image processing. Selecting the appropriate hardware is crucial for achieving 

optimal performance. 

  



 

 

 

    

Release Notes 

 

Dragonfly 3D World, Version 2025.1 
2025-09-11 

 Page 41 of 137 

    

4.1 GPGPU Preferences 

You must select the Miscellaneous preference Use GPGPU acceleration (when available), as shown 

below, to run applicable operations with GPGPU acceleration. If not selected, the CPU equivalent will be 

used. 

 

Miscellaneous preferences 

4.2 GPGPU Accelerated Image Filters 

The following image filters have been integrated within the GPGPU framework. 

In most cases, you should not notice any differences between the image filtering outputs of GPGPU versus 

CPU processing. You can verify this by comparing the structural similarity index (SSIM) of the GPGPU and 

CPU outputs in Dragonfly’s Processed Image Comparator. 

Filter Description 

Bilateral 
This smoothing filter preserves edges and reduces noise by averaging pixels based 

on their spatial closeness and radiometric similarity. 

Canny 

This multi-stage edge detector uses a filter based on the derivative of a Gaussian in 

order to compute the intensity of the gradients. 

NOTE The settings for this filter now include the option to select the low and high 

thresholds for hysteresis thresholding. Hysteresis thresholding on the gradient 

magnitude determines which edge pixels are kept or removed from the output. 

Close 
This morphology filter smooths objects and fills-in small holes by performing dilation 

followed by erosion using the same structuring element for both operations. 

Dilate 
This morphology filter enlarges the boundaries of regions of foreground pixels, 

typically white pixels, using a structuring element. 

DoG (Difference of Gaussian) 

This edge detection filter first performs a Gaussian blur at a specified standard 

deviation (first sigma) and then another blur less than the first (second sigma). The 

final image is then calculated by replacing each pixel with the difference between the 

two blurred images and detecting where the values cross zero. 

Erode 
This morphology filter erodes away the boundaries of regions of foreground pixels, 

typically white pixels, using a structuring element. 
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Filter Description 

Gaussian 
This smoothing filter applies a convolution operation with a Gaussian filter kernel to 

smooth images. 

Kuwahara This smoothing filter provides non-linear smoothing for adaptive noise reduction. 

Laplacian 

This edge detection filter highlights the regions in which there is a rapid intensity 

change using a discrete convolution kernel that approximates the second derivatives 

of the image in the definition of the Laplacian. 

Mean This smoothing filter replaces each pixel with the mean value of its neighbors. 

Median 
This smoothing filter replaces each pixel with the median value of its neighbors, 

which can be highly effective on salt-and-pepper noise. 

Non-local means 
A 3D version of the non-local means filter, which smoothes images by taking a mean 

of all pixels weighted by how similar the pixels are to the target pixel. 

Open 
This morphology filter performs an erosion operation, followed by a dilation to 

smooth objects and remove isolated pixels. 

Sobel 

This edge detection filter named after Irwin Sobel creates an image which 

emphasizes edges and transitions. 

NOTE The GPGPU version of the Sobel filter was updated to the ‘classical’ version of 

this filter. 

Unsharp 
This filter sharpens an image by subtracting a blurred version of itself from the 

original. 

Available GPGPU operations for image filtering 

4.3 GPGPU Acceleration for Processing Images 

The following items are available for executing operations on images within the GPGPU framework. 

Operation Description 

Surface determination 

Accelerates surface determination for the generation of precise meshes (see 

Surface Determination Tool for additional information about surface determination 

in this 3D World release). 

Available GPGPU operations for processing images
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4.4 Processing ROIs with GPGPU Acceleration 

The following items are available for executing operations on regions of interest within the GPGPU 

framework. In some cases, you may notice minor differences in the outputs of GPGPU versus CPU 

processing. This is due to the differences between the algorithms implemented. 

Operation Description 

Ambient occlusion (AO) fields 
Used for segmenting pores and cavities in 3D images (see Ambient Occlusion 

(AO) Fields for additional information about this newly implemented algorithm). 

3D thinning 

This operation for skeletonization, which is a preliminary step for computing 

graphs, is accelerated within the GPGPU framework. 

NOTE Although the overall shapes of skeletons generated from GPU and CPU 

processing are usually identical to each other, the GPU-based result often contains 

fewer unnecessary branches. 

Distance maps 
Distance map computations, which are used in a number of transform processes, 

are accelerated within the GPGPU framework. 

Ultimate erode 

This new operation automatically creates a seed multi-ROI that finds the centers of 

mass of the objects within a region of interest that would be separated by 

segmentation (see Create Seeds for Watersheds (Ultimate Erode)). 

Available GPGPU operations for regions of interest  
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5 Meshes 

New features and optimizations for generating and visualizing meshes available in this software release 

include an advanced surface determination tool for generating high precision meshes, optimal meshes for 

balancing complexity with your system’s capability to render meshes in 3D, height maps for revealing 

deviations from a referenced plane, and improvements for viewing meshes in outline mode and with 

shadows. 

NOTE This software release also provides a configurable snapping behavior for the Points, Ruler, Angle, Path, and 

Arrow annotation tools. This lets you quickly and precisely place control points for the most accurate mesh 

measurements (see Use Snapping for additional information about this new feature). 

5.1 Surface Determination Tool 

With 3D World’s new advanced Surface Determination tool, measurement uncertainty is reduced by 

providing adaptive surface determination options for generating high precision meshes with sub-voxel 

resolution from scans of castings and other single-phase materials. The Surface Determination tool lets you 

specify search distances for precise boundary detection, denoise input data, exclude internal voids, adjust 

thresholds and falloff snap factors, as well as quickly refine initial results for precise vertex positioning based 

on geometric accuracy. 

The advantages of the Surface Determination tool, as compared to the marching cubes method, include 

better quality with the same number of polygons, decreased video memory requirements, as well as 

accelerated processing within the GPGPU framework (see GPGPU Acceleration). 

An example of meshes generated in a previous 3D World version versus with the Surface Determination tool 

in version 2025.1 is shown below. 

 

Mesh generated from a scan in a previous version (left) and in version 2025.1 (right) 

NOTE The Surface Determination Tool is not yet macro compliant. Macro compliance will be implemented in a future 

software release.  
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Right-click an image and then choose Surface Determination in the pop-up menu to open the Surface 

Determination panel on the Dataset Tools panel, as shown on the following page. 

 

Surface Determination panel 

The following settings are available for generating meshes using the surface determination method. You 

should note that the default settings should work well in many cases. 

Item Description 

Object 
Indicates the currently selected input object. If required, you can select another object in the 

drop-down menu to generate a surface. 

Use mask 

If checked, lets you choose a region of interest to initialize the surface. For example, if you need 

to generate a surface from a segmentation. 

NOTE If the region of interest designated as the mask is a void, then you will need to select 

‘Invert search’ to generate a surface. 

Keep surface details 

If checked, smoothing and other filtering pre-processing steps will not be applied when the 

mesh surface is generated. This setting is usually checked only when you want to preserve 

dataset details for surface roughness or other similar computations, as shown below. 

 

Keep surface details not applied (on left) and applied (on right) 
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Item Description 

Denoise dataset 
If checked, 3D non-local means filtering will be applied as a pre-processing step to reduce 

effects that can translate to noise. 

Preview 

Check this option to preview what the generated surface will look like and the extent of the 

search distance. An example of a preview is shown below. 

 

Merge vertices 

If checked, excess vertices will be merged when the mesh is ‘shrink-wrapped’ to the computed 

surface. 

NOTE Selecting this setting can help reduce the occurrence of ‘loops’ in generated meshes, as 

shown below. 

 

Original surface (on left) and the same surface after merging vertices (on right) 

Exclude internal voids If checked, internal voids will be excluded from the generated mesh. 

Auto adjust falloff 

If checked, the falloff snap factor will be adjusted locally. If not checked, the global value set for 

‘Falloff snap factor’ will be used. 

NOTE See ‘Falloff snap factor’ for additional information about this parameter. 

Invert search 
If checked, the default search direction will be inverted. 

NOTE Select this setting if you are using a mask that defines void space. 
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Item Description 

Advanced parameters 

Check this option to access the advanced parameters, shown below. 

 

Use Otsu… If checked, the computed Otsu threshold will be applied automatically to generate 

the initial surface. If unchecked, you can manually set the threshold value. 

Show threshold… If checked, a colored highlight will be applied within the defined range, as 

shown below. 

 

Sampling… Lets you set the sampling rate that will be applied along each axis. At a setting of 

4, one of every four pixels will be sampled. Each pixel value is analyzed when the sampling 

values are set at 1.  

Falloff snap factor 

Determines how aggressively snapping to the intensity falloff from the surface will be. As shown 

in the following intensity profile, the falloff snapping factor is average at a setting of 0.5. 

Snapping will be more aggressive with settings greater than 0.5 and less aggressive with 

settings lesser than 0.5. 
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Item Description 

Relaxation 

Determines the number of iterations that will be performed in each direction to search for the 

surface. Searching will be done once at a setting of 1.0, two iterations will be performed at a 

setting of 0.5, and five iterations will be performed at a setting of 0.2. over 50% of the search 

distance. will be twice as long as at a setting of 1.0. 

NOTE Increasing the number of iterations may increase accuracy, but more time will be required 

to compute the surface.  

   

Relaxation = 1.0 

Searches once. If ‘crossovers’ 

occur, as shown above, you 

should consider adding 

iterations. 

Relaxation = 0.5 

Searches two times, i.e., 50% of 

the search distance for each 

iteration. 

Relaxation = 0.2 

Searches five times, i.e., 20% of 

the search distance for each 

iteration. 

Search distance 

(pixels) 

Lets you set a search distance to find the ‘real’ surface between the material and air. 

The effect of applying varying search distances is shown below. You can increase the search 

distance in cases in which the generated surface to too far from the real surface. 

 

NOTE Click the Preview button to view a graphical representation of the search distance. The 

search distance should be large enough to include all of the object’s edges, but not too large as 

this could slow down computations. 

Apply Default Click this button to reset all settings to their default values. 

Generate Surface 

Click this button to generate an initial surface. 

NOTE You can refine unsatisfactory surfaces by modifying the current settings for ‘Preserve 

surface details’, ‘Falloff snap factor’, ‘Relaxation’, or ‘Search distance’. 

Refine 

Click this button to refine the currently computed surface after any changes were made to the 

settings for ‘Preserve surface details’, ‘Falloff snap factor’, ‘Relaxation’, or ‘Search distance’. 

NOTE You will need to generate a new surface if you change the threshold value or change the 

current setting for ‘Denoise dataset’. 
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Item Description 

Post-Processing 

The options in the Post-Processing box, shown below, let you remesh the current surface with 

Poisson surface reconstruction at a selected quality setting to generate a more uniform 

topology. 

 

Quality settings… Lets you choose the quality setting — Low quality (fast), Normal quality, 

or High quality (slow) — that will be applied to remesh the surface. 

 

Remesh Surface… Click this button to remesh the current surface. 

Show remeshed surface… Lets you toggle the visibility of the current surface, which is shown 

when unchecked, with the remeshed surface, which is shown when checked. 

NOTE In general, surfaces should only be remeshed when there were issues that cannot be 

corrected otherwise. As shown in the example below, noisy surfaces can be corrected with 

remeshing. 

 

Original surface (on the left) compared to remeshed surface (on the right) 

Done 

Lets you apply all selected changes to the mesh and closes the Surface Determination panel. 

The computed mesh will then be available on the Properties panel for inspection and for taking 

measurements. 
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5.2 Optimal Meshes 

Generated meshes are sometimes too complex and need to be decimated to be rendered in the 3D view on 

some systems. The new Optimal mesh options, shown below, provides a balance between complexity and a 

system’s capability to render the mesh in 3D. 

    

Optimal mesh export options 

NOTE You can also export optimal thickness meshes from multi-ROI classes, as shown below. 
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5.3 Mesh Tools 

This software release includes new mesh tools that let you cut a mesh with a box.  

Do the following to cut a mesh with the Mesh tools: 

• Create and align a box shape that defines the area you want to cut. 

• Right-click the box and choose Mesh Tools in the pop-up menu, as shown below to access the cut 

mesh options. 

 

• Choose the required option as follows: 

Keep Inside of Box from Mesh… If selected, edges and vertices outside of the box will be cut from 

the mesh. 

Cut Inside of Box from Mesh… If selected, edges and vertices inside the mesh will be cut from the 

mesh. 

5.4 Height Maps 

This software release provides the option to compute distances from a mesh to a plane parallel to it. As 

shown below, the distance from a plane can reveal surface undulations by showing how far they deviate from 

the plane. 

 

Scalar values of distance computed from a plane 
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The option to compute distances from a plane is available in the Compute Measurements dialog, shown 

below. You will need to select the referenced plane in the Plane drop-down menu. 

 

Compute Measurements dialog 

5.5 Improvements for Viewing Meshes 

A number of improvements for viewing meshes in Outline mode and with shadows are available in this 

software release. 

5.5.1 Outline Mode 

Improvements for viewing meshes in Outline mode, in which meshes are shown as both solid and in 

wireframe, are available in this software release. As shown below, surfaces are now more clearly 

distinguishable in the Outline mode. 

 

Comparison of Outline mode for meshes in previous version (left) and in version 2025.1 (right) 
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5.5.2 Lighting with Shadows 

Improvements for viewing meshes with shadows is available in this software release. This improvement, 

which has low system requirements compatible with low powered GPUs, uses ‘depth darkening’ to improve 

shadowing and produce a more accurate sense of ‘depth’. 

 

Comparison of Outline mode for meshes in previous version (left) and in version 2025.1 (right) 

5.5.3 Imported Meshes 

You should notice that the visualization of meshes created in CAD software and exported in the STL  

(*.stl extension) file format should be noticeably improved in this software release. 

 

STL file in Dragonfly 3D World 2024.1 (left) and in 2025.1 (right) 

NOTE This also includes improvements for imported annotations that were saved in the STL file format, such as 

landmarks. 
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5.6 Exporting Meshes with Colors in PLY 

In previous versions of Dragonfly 3D World, it was only possible to export meshes with colors preserved in 

the VRML (*.wrl extension) file format. This software release provides the additional option to export meshes 

with colors preserved in the PLY (*.ply extension) file format. 

Right-click the mesh you want to export and then choose Export > Mesh to File with Color in the pop-up 

menu. You can then choose the PLY or VRML file format and other settings in the Save As dialog. 

NOTE Importing meshes with color is not supported by Dragonfly 3D World. 

5.7 Exporting 3D Tetrahedral Meshes 

This software release provides additional options for exporting 3D tetrahedral meshes created in Dragonfly’s 

NGSolve plugin and in the Generate 3D Tetrahedral Mesh dialog. Right-click the required 3D tetrahedral 

mesh and then choose Export > Tetrahedral Mesh to File in the pop-up to the additional export formats, as 

listed in the following table. 

File Format Extension 

OpenFOAM 1.5+ mesh *.foam 

Stereolithographic extended surface triangular mesh *.stl 

Neutral Format mesh *.neu 

Surface Mesh Format *.mesh 

Tochnog Format *.dat 

Abaqus Format *inp 

Fluent Format *cas 

Permas Format *.mesh 

FEAP Format *.mesh 

Elmer Format *.grd 

Gmsh2 Format *.gmsh2 

Export formats for 3D tetrahedral meshes 
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6 Volume Sculptor 

The Volume Sculptor available in version 2025.1 lets you simplify the visualization of 3D renderings by 

automatically masking selected regions. As shown below, a selected region or its inverse can be quickly 

hidden from view with the tools available on the Volume Sculptor panel. You can also create new datasets by 

cutting sculpted regions from the original data. 

 

Original rendering with drawn rectangular sculpting region (left), with sculpting applied (middle), and inverted sculpting 

applied (right) 

The options on the Volume Sculptor panel, shown below, let you draw, clear, and invert the volume sculpting 

mask, as well as undo the last operation that was performed. 

 

Volume Sculptor panel 

Tool/Operation Icon Description 

Rectangular region 
 

You use the Rectangle tool to select a rectangular portion of the rendering in 3D 

views. 

• While holding down LEFT CTRL, drag to shape and size the rectangular region. 
Release the mouse and keyboard key to create the region. 

Ellipse region 
 

You use the Ellipse tool to select an elliptical portion of the rendering in 3D views. 

• While holding down LEFT CTRL, drag to shape and size the elliptical region. 
Release the mouse and keyboard key to create the region. 

Polygon region 
 

You use the Polygon tool to select a polygonal portion of the rendering in 3D views. 

• While holding down LEFT CTRL, click on a succession of points to define the 
contour of the region. Release the keyboard key to create the region. 

Freehand region 
 

You use the Freehand tool to select a freehand portion of the rendering in 3D 

views. 

• While holding down LEFT CTRL, drag to define the required contour. Release the 
mouse and keyboard key to create the region. 
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Tool/Operation Icon Description 

Cut from volume/Create 

new volume  

Lets you cut data from the current sculpted volume or to create a new volume. 

Cut current volume… Cuts data from the current sculpted volume. In this case, 

you will need to save the loaded data if you want to keep your changes. 

Create new volume… Creates a new volume in which the only the sculpted data 

is retained. 

NOTE In both cases, data is excluded from the volume by overwriting data values in 

the masked region with the minimum data value available. 

Clear 
 

Clears all labeled voxels in the mask. 

Invert 
 

If clicked, all labeled voxels in the mask will be inverted. This means that very voxel 

that is not labeled in the selected region of interest will be labeled, while every 

voxel that was previously labeled will be unlabeled. 

Undo 
 

Undoes the last labeling operation that was performed. 
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7 Effect Splitter 

This software release includes an ‘effect splitter’ that lets you split the currently selected 3D view into two 

horizontal windows with an adjustable slider. You can then apply different 3D effects to objects in each half 

of the view, such as edge contrast and opacity, or you can clip objects to reveal an original input and a 

processed output. 

As shown below, a split 3D view can show the original rendering (on the left) and with edge contrast applied 

to the same data to reveal the interior of the object (on the right). 

 

Split 3D view with edge contrast applied on the right 

A split view can also contain multiple objects, as shown below. In this case, an original rendering can be 

clipped on one side to let you show a processed output on the other side. 

 

Split 3D view of 3D rendering (left) and thickness mesh (right) 

Sweeps of split views can be included in animated sequences to show the transition from one 3D effect to 

another over the whole view. 



 

 

 

    

Release Notes 

 

Dragonfly 3D World, Version 2025.1 
2025-09-11 

 Page 58 of 137 

    

Click the Splitter button on the Shapes panel, as shown below, to split the selected 3D view and add 

‘splitter’ shape to the Data Properties and Settings panel. 

 

Shapes panel 

You can select the effect(s) that will be applied on each half of the split view in the Shape properties box, as 

shown below. 

 

Shape properties for splitters 

7.1 Configurable Actions for the Splitter 

The following actions can be configured for splitters. 

Action Key Mouse 

Move the view splitter  Left mouse 

Configurable actions for the splitter 
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8 Brightness, Contrast, and HSL Settings 

This software release includes a new dialog — Brightness/Contrast — that lets you adjust the brightness and 

contrast of rendered objects in 3D views, as well as set hue, saturation, and luminosity settings. Click the 

B/C button on the Scene’s Views Properties panel, as shown below, to open the Brightness/Contrast dialog. 

 

Scene’s Views Properties panel 

You can use the sliders in the Brightness/Contrast dialog to adjust the brightness, contrast, hue, saturation, 

and luminosity of rendered objects in the current 3D view, as well as set values in the text boxes or with the 

up-down controls. You should note that all objects in the 3D view, except for the background, will be affected 

by the selected Brightness/Contrast settings. 

 

Brightness/Contrast dialog 

Brightness… Makes rendered objects appear lighter or darker. You should note that increasing brightness 

can help reveal hidden details but may also make images look washed out. In most cases, you can bring 

back the details and depth of renderings by adjusting contrast. Values can range from -100 to +100. 

Contrast… Alters the difference between light and dark tones. Higher contrast makes details stand out by 

emphasizing dark areas and highlights, while lowering contrast can create a more uniform, muted look. 

Values can range from -100 to +100. 

Hue… Shifts the tones of objects by changing the overall color palette. The values displayed reflect the 

number of degrees of rotation around a color wheel. A positive value indicates clockwise rotation, while a 

negative value indicates counterclockwise rotation. Values can range from -180 to +180. 



 

 

 

    

Release Notes 

 

Dragonfly 3D World, Version 2025.1 
2025-09-11 

 Page 60 of 137 

    

Saturation… Controls the intensity of color tones. Increasing saturation will make colors more vivid and 

vibrant, while decreasing saturation will move tones toward grayscale to create an appearance that is more 

subdued or desaturated. Values can range from -100 to +100. 

As shown below, selecting hue and saturation settings can fully change the visualization of grayscale 

images. 

 

Lego man with hue and saturation settings applied 

Luminosity… Affects the perceived brightness of grayscale/color tones, independent of their hue or 

saturation. Adjusting luminosity can make objects appear lighter or darker without significantly altering their 

vibrancy. Values can range from -100 to +100.  
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9 3D Settings for Images 

Updated 3D settings for images — Unsharp, Noise reduction, and Edge Contrast — were incorporated in 

Dragonfly 3D World 2025.1. These settings are available in the 3D settings box on the Data Properties and 

Settings panel. 

 

3D settings box 

9.1 Unsharp 

Providing better sharpening and more surface details, the Unsharp option available in this software release 

adjusts the amount of sharpening per voxel to target an even level of sharpness across images. Areas that 

are already sharp are sharpened less, while areas that lack detail are sharpened more. This allows for higher 

overall natural visual sharpness with fewer artifacts. 

Check the ‘Unsharp’ option in the 3D settings box on the Data Properties and Settings panel to apply this 

filter to your 3D renderings. The effect of sharpening, which needs to be used with lighting, is shown in the 

following example. 

 

Before (left) and with unsharp applied (right) 
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9.2 Noise Reduction 

This software release provides improved denoising of 3D textures with the application on non-local means 

filtering in 3D that maintains details and edge sharpness. As shown in the following screenshots, the result is 

a smoother and more visually appealing rendering. 

 

Before (left) and with noise reduction applied (right) to a powder dataset 

This setting filters the 3D texture, but does not impact original data, does not need extra RAM or VRAM, and 

can be applied in less than 1 second for dataset of 1024 × 1024 ×1024 pixels. 

9.3 Edge Contrast 

You should note that visualizations produced with the ‘Edge contrast’ applied are improved in this software 

release. 

 

Before (left) and with edge contrast applied (right) to an automotive part  
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10 Projected Grids 

The option to display a projected grid of the clip box is available in the Clip box on the Data Properties and 

Settings panel. Projected grids can provide a good representation of the size and dimensions of objects 

within a volume and can also help you to quickly identify spatial relationships within the data. You should 

note that you can display the grid when the clip box is hidden, as shown below. 

 

Grid displayed on segmented dataset 

Set the clip box as required and then check the ‘Display grid on object’ option in the clip box, as shown 

below, to project the grid lines of the clip box on objects in the 3D view. You should not that you can adjust 

the grid size, as well as display the grid even when the clip box is hidden. 

 

Display grid on object option 

NOTE Projected grids are only available for images. This option is not available for regions of interests, multi-ROIs, 

meshes, and other objects. 
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11 2D Processing of ROIs and Multi-ROIs 

In cases in which you work with disconnected stacks of images instead of volumetric data or need to work 

strictly slice-by-slice, this software release provides a number of tools for processing and analyzing your data 

in 2D. This includes processing islands in 2D, creating new multi-ROIs of connected components based on 4 

and 8 connectivity, applying 2D watershed transforms, skeletonization, and computing distance maps in 2D. 

11.1 Process Islands in 2D 

You can now choose to refine a region of interest by processing islands slice-by-slice in the Z axis. Right-

click a region of interest and then choose Process Islands 2D in the pop-up menu, as shown below, to 

access the options for removing or keeping islands. 

 

Process Islands 2D pop-up menu options for refining regions of interest 

You should note that connectivity is the way in which a set of pixels are connected to each other and is 

selectable for processing islands, as explained below. 

4-connected… Labeled pixels are considered to be connected if any of their edges are adjacent to the 

current seed. This results in the maximum number of connected components. 

8-connected… Labeled pixels are considered to be connect if any of their edges or corners are adjacent to 

the current seed. This results in the fewest number of connected components. 
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11.2 Connected Components 2D 

This software version lets you create new multi-ROIs of connected components on a slice-by-slice basis in 

the Z axis. This enables the computation of 2D measurements from multi-slice datasets as each label will be 

on a different slice. 

Right-click the required region of interest or multi-ROI and then choose Connected Components 2D in the 

pop-up menu to see the options for creating new multi-ROIs with 2D connected components. 

 

Connected Components 2D sub-menu for regions of interest 

Create New Multi-ROI (4-connected)… Creates a new multi-ROI in which groups of connected voxels are 

labeled as distinct objects on a slice-by-slice basis along the Z-axis. Propagation is done using the 4 edges 

adjacent to the current seed and will result in the maximum number of connected components. 

Create New Multi-ROI (8-connected)… Creates a new multi-ROI in which groups of connected voxels are 

labeled as distinct objects on a slice-by-slice basis along the Z-axis. Propagation is done using the 4 edges 

and 4 corners adjacent to the current seed and will result in the minimum number of connected components. 

11.3 2D Distance Maps 

Distance maps (also called distance transforms), which are powerful tools for image segmentation and 

analysis tasks, are typically used for watershed transforms and for estimating local thickness. This software 

release includes the option to compute 2D distance maps, which are computed on a slice-by-slice basis in 

the Z-axis. 

Right-click the required region of interest and then choose Create Mapping Of to access the options for 

computing distance maps, as shown below. 

 

Region of interest contextual menu options for creating mappings 
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11.4 2D Watersheds 

Watersheds, which are primarily used for image segmentation, are particularly useful for dividing touching or 

overlapping objects. In previous Dragonfly 3D World versions, watersheds could only be applied in 3D. This 

release provides the additional option of applying watersheds in 2D, in which case the selected algorithm will 

be applied on a slice-by-slice basis along the Z-axis. It is also possible to apply the ‘Compute Watershed 2D 

with Plane’ algorithm to a single slice in any selected orientation. 

As shown below, the typical inputs for a watershed are mask regions of interest (in blue) and seeds multi-

ROIs (multi-colored). The output of applying watersheds in 2D are labels created on each Z-axis slice (as 

shown on the middle screenshot) or on a single slice with applied with a plane (as shown on the bottom 

screenshot). 

 

Mask region of interest and seeds multi-ROI (top) and resulting 2D watershed (bottom) 

11.4.1 Adaptive Watershed 2D 

The Adaptive Watershed segmentation technique is an image segmentation method that utilizes the 

principles of watershed transformation. The ‘adaptive’ aspect refers to the recognition of overlapping elliptical 

objects in the image being segmented, which allows for more accurate segmentations of various particles. 

Right-click the required region of interest and then choose Adaptive Watershed 2D in the pop-up menu to 

apply the Adaptive Watershed algorithm on a slice-by-slice basis along the Z-axis. 

11.4.2 Compute Watershed 2D and Watershed Transform 2D 

In addition to providing the Adaptive Watershed method in 2D, Dragonfly 3D World also includes 2D versions 

of the Compute Watershed and Watershed Transform algorithms. Right-click the required multi-ROI and then 

choose Compute Watershed 2D or Watershed Transform 2D in the pop-up menu to apply the algorithms 

on a slice-by-slice basis along the Z-axis. The difference between the two implementations is that a Sobel is 
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computed automatically for the selected landscape image when the Watershed Compute 2D algorithm is 

applied. Both options also include a mask to define the working space for the transformation. 

11.4.3 Compute Watershed 2D with Plane 

As an alternative to computing watersheds in 2D along the Z-axis, this additional option lets you choose an 

orientation, or ‘plane’, to apply the watershed. The result is a watershed applied to a single slice in the 

selected orientation. 

 

Region of interest for computing the distance map (blue) and seeds multi-ROI (top) and resulting 2D watershed 

computed with a plane (bottom) 

Do the following to compute this watershed: 

• Select the required 2D view and scroll to the required image slice. 

• Right-click the multi-ROI that defines the seeds for the watershed. 

• Chose Compute Watershed 2D with Plane in the pop-up menu. 

• Choose the ROI to compute a distance that defines the regions of interest in the Choose the ROI to 

Compute a Distance Map dialog, as shown below. 

 

• Click OK to compute the watershed. 
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11.5 2D Graphs 

Graphs computed from regions of interest typically provide an opportunity to characterize and model a set of 

connected areas in 3D, such as tortuous pore space, with spheres and lines representing those areas and 

their connections. Associated scalar values, such as Euclidean length, and segment tortuosity, length, and 

Euclidean, can be colored mapped to edges and vertices for sparse and dense graphs. 

In this software release, you can also compute graphs on a slice-by-slice basis. Right-click the required 

region of interest and then choose 3D Modeling to access the options for computing graphs in 2D, as shown 

below. 

 

Region of interest contextual menu options 

You should note that graphs computed in 2D have the additional parameter ‘Z Slice Index’ for edges and 

vertices. This parameter, circled below, can help you identify each section of the graph. 

 

Graph settings  
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11.6 Skeletonize ROI 2D 

A 2D implementation of skeletonization, which reduces regions to a skeletal remnant that preserves the 

extent and connectivity of the original region, is available in this software release for feature extraction, 

representing an object’s topology, or for other functions. 

Right-click the required region of interest and then choose Skeletonize ROI 2D in the pop-up menu to apply 

skeletonization on a slice-by-slice basis computed in the Z-axis. 

 

Input region of interest (blue) and ROI skeletonized in 2D (orange) 
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12 Multi-ROIs 

A number of new features — an Instance Labeler, conversion of color images to multi-ROIs, width 

measurements, and other updates — are available for multi-ROIs in version 2025.1. 

12.1 Instance Labeler 

This new utility for labeling the objects in multi-ROIs lets you define new scalar value slots and then assign 

labels to instances within that slot. For example, you could create a new slot called ‘classification’ and then 

assign classes such as ‘defective’ and ‘non-defective’ to instances of the distinct objects.  

Select the required input image and output multi-ROI, right-click, and then choose Open Instance Labeler to 

open the Instance Labeler context, as shown below. 

 

Instance Labeler contextual window and Instance Labeler panel 

The Instance Labeler can be used to prepare training sets for classification models (see Deep Model(s) for 

Image Classification). 
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The Instance Labeler panel is shown below. 

 

Instance Labeler panel 

Item Description 

Slot 
Lets you choose a scalar values slot for labeling instances. You can also create a new slot, 

if required. 

Number of class(es) 

Lets you set the number of classes that can be applied to instances. For example, you 

would select 2 classes if you plan to train a classification model to identify instances as 

‘defective’ or ‘non-defective’. 

Sorting 
Lets you choose the sorting method — Normal, Random, Spatial X, or Spatial Y — that will 

be applied when you advance through the instances within the multi-ROI. 

Visibility 

Determines how the multi-ROI will be shown in the workspace. 

Show only contour… If checked, only the contours of each instance in the multi-ROI will 

appear in the 2D views. 

Eye icon… Lets you toggle the visibility of the multi-ROI in all views. 

3D… Lets you toggle the visibility of the multi-ROI in the 3D view. 

Import/Export 
Lets you export and import the selected labeling settings selected for the Instance Labeler in 

the Pickle (*.pkl extension) file format. Pickle is a Python-specific binary file format. 

Previous/Next 

Automatically selects and fits each instance in the views. You can simply label the selected 

instance by clicking color swatches at the bottom of the panel. 

Previous… Click the Previous button to select and fit the previous instance in the views, as 

determined by the selected sorting method. 

Next… Click the Next button to select and fit the next instance in the views, as determined 

by the selected sorting method. 

Color swatches You can click any of the color swatches to label the selected instance. 

Instance Labeler settings and options  
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Whenever all required instances are labeler, you can close the Instance Labeler and generate a multi-ROI 

from the labels. A generated multi-ROI from a labeling workflow is shown below. 

 

Multi-ROI with labels for ‘defective’ (red) and ‘non-defective (green) 

12.2 Split Tool 

Previous versions of Dragonfly 3D World ZEISS edition included a split tool in the Object Analysis dialog to 

split clustered objects. This functionality is now available in a dedicated Multi-ROI Split Tool dialog.  

Right-click a clustered object in the Classes and scalar information box and then choose Launch Split Tool 

in the pop-up menu to open the Multi-ROI Split Tool dialog, shown below. 

 

Multi-ROI Split Tool dialog 

NOTE The Multi-ROI Split tool is only available for the ZEISS edition of Dragonfly 3D World. Contact 

sales.dragonfly@comet.tech for information about the availability of this version of Dragonfly. 
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The following controls and settings are available in the dialog. 

Setting Description 

Show Seeds 

Click the Show Seeds button to compute the distance map that will be used to enable the 

segmentation of clustered objects. The proposed split with the selected threshold will appear 

as an overlay, as shown below. 

 

Keep showing seeds in real time… If checked, seeds will be shown automatically whenever 

you select another clustered object, either when you select it with the Pick tool or in the 

Classes and scalar information box. 

Update Seeds… Lets you update the visibility of seeds whenever another clustered object is 

selected and the option ‘Keep showing seeds in real time’ is not checked. 

Threshold Lets you adjust the threshold of the distance map that is used to separate clustered objects. 

Apply 
Applies the split operation to the selected clustered object. The separated objects will appear 

in the Classes and scalar information box. 

Undo Undoes the last applied operation. 

Close Closes the Multi-ROI Split Tool dialog. 

Screenshots of a multi-ROI with clustered objects and after the objects were split are shown below. 

 

Original multi-ROI (on left) and multi-ROI after clustered objects were split (on right) 
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12.3 Create Colored Multi-ROI From RGB Channels 

You can convert the red-green-blue channels of imported color images to multi-ROIs in which each voxel is 

assigned a unique color that matches the color image. As shown below, the red, green, and blue channels of 

an RGB image were converted to a new multi-ROI with a color palette that mimics the colors in the original 

image. 

 

Colored multi-ROI from RGB image channels of a color image of HEK293 cells 

Do the following to create a colored multi-ROI from RGB image channels: 

• Load the selected color image as three separate channels. 

• Select the loaded image channels, right-click, and then choose Create Colored Multi-ROI From 

RGB Datasets in the pop-up menu. 

• Choose the red, green, and blue channels in the Choose RGB Datasets dialog. 

12.4 Longest Length Measurements 

Width, which represents the maximum thickness or diameter of a structure at its thickest point, is now 

available for longest length computations. This measurement is particularly useful for analyzing pores, fibers, 

or any tubular structures for which you need to know the largest cross-sectional dimension. 

Right-click a multi-ROI and then choose Measurements and Scalar Values > Compute Measurements to 

open the Compute Measurements dialog. As shown on the following screenshot, you can expand the 

Longest Length category to view available measurements for longest length. 
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Longest length measurements 

12.5 Create Boxes From Classes 

You can now create single and multiple boxes for the selected classes of a multi-ROI. 

 

Single bounding box created for a selected class (left), multiple boxes created for selected classes (middle), single box 

created for multiple classes (right) 

The options for creating boxes from a selected multi-ROI class or classes are available in the Classes and 

Scalar Information pop-up menu, as described below. 

Create Bounding Box of Class… Automatically creates a box that encloses the labeled voxels of the 

selected class. Available when a single class is selected. 

Create Individual Boxes From Classes… Automatically creates a series of boxes that enclose the labeled 

voxels of each selected class. Available when multiple classes are selected. 

Create Bounding Box for all Classes… Automatically creates a box that encloses the labeled voxels of all 

selected classes. Available when multiple classes are selected. 
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12.6 Class Selection Options 

Two new buttons — Select All and Invert Selection — are now available in the Classes and scalar 

information’ box for selecting all classes in the list or for inverting the current selection, respectively.  

 

Classes and scalar information box  
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13 Regions of Interest 

New features and settings for regions of interest are described in this topic. 

13.1 Create Seeds for Watersheds (Ultimate Erode) 

One of the challenges of computing watersheds is creating the seeds to initialize the operation. To help 

overcome this challenge, this software release includes the option to create seeds from an ultimate erode. 

Ultimate erodes automatically find the centers of mass of objects within a region of interest that would be 

separated by segmentation and create seed multi-ROIs as a result. The seeds, as shown below, can be 

used as an input for watershed segmentations. 

 

Original region of interest (left), computed seeds for watershed (center), and the regions expanded with a watershed 

transform (right) 

Right-click a region of interest and then choose Create Seeds for Watersheds (Ultimate Erode) in the pop-

up menu to open the Ultimate Erode dialog, shown below. You can set the extent of seed expansion, as well 

as the size of the resulting seeds, in the Ultimate Erode dialog. 

 

Ultimate Erode dialog 

NOTE In most cases, watershed segmentations work best for smooth convex objects that do not overlap extensively. 
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13.2 Opacity and Color Settings 

Updates are available in this software release for applying smoothing and edge contrast to adjust the 

visualization of regions of interests. These options are available in the Opacity and color box on the Data 

Properties and Settings panel. 

 

Opacity and color settings for regions of interest 

13.2.1 Smoothing 

Implemented improvements for smoothing regions of interest result in cleaner visualizations in which 

staircasing effects are minimized, as shown below. Selecting the ‘Smoothed (global)’ setting in the Opacity 

and color box applies Gaussian filtering to the alpha channel of the ROIs to improve visualizations. 

 

Before (left) and after smoothing applied to a region of interest (right) 
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13.2.2 Edge Contrast 

In some cases, you may want to produce images in which edges of a region of interest are emphasized and 

other features are semi-transparent. As shown below, the ‘Edge contrast (global)’ setting now offers better 

modulation and control for fine-tuning visualizations that include regions of interest.  

You can adjust the degree of edge contrast with the Highlight slider, as shown on the following screenshot. 

   

Edge contrast applied to a region of interest (with green highlight) 

13.3 Skeletonize and Prune ROI 

A new item for 3D modeling — Skeletonize and Prune ROI — lets you extract a selected number of paths 

that will be included in a graph generated from a skeletonized region of interest. You should note that 

skeletonization includes repeatably removes pixels from the edges of regions of interest until they are 

reduced to single pixel wide skeletons that retain the original shape of the ROI. 

 

Skeletonized ROI with 12 paths (left) and fully skeletonized ROI (right) 
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Right-click the required region of interest and then choose Skeletonize and Prune ROI in the pop-up menu. 

You can then choose the number of paths that will be retained in the Prune ROI dialog, shown below. 

 

Prune ROI dialog 

You should note that the algorithm measures the distance from all end nodes and then selects the longest 

path to prune. The number of branches of that path that will be included is determined by the number of 

paths entered in the Prune ROI dialog. 

14 Statistical Properties for ROIs and Multi-ROIs 

A new statistical property, called ‘Labeled voxels on slice’, is available in the Statistical properties box for 

ROIs and multi-ROIs. This new parameter indicates the total number of labeled voxels on the current slice in 

the selected 2D view. 

 

Statistical properties for a multi-ROI 

The labeled voxels on slice count will be updated automatically each time that the slice is changed, the view 

is modified, or if another 2D view is selected. You can also click the Refresh button or update the count if 

you modify the current labeling. 
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15 Analyze and Classify Measurements 

Correlation matrices, opacity controls, a Pick tool, and other additions are available for analyzing and 

classifying measurements in the Dragonfly 3D World version 2025.1 release. 

IMPORTANT Please note the Object Analysis plugin is no longer available for Dragonfly 3D World as of version 2025.1. 

You should find all of the same features in the Analyze and Classify Measurements dialog, as well as a 

number of additional functions. For ZEISS edition users, the split functionality is now available in a 

dedicated plugin (see Split Tool). 

15.1 Compute Correlation Matrix 

This software release provides the opportunity to compute correlation coefficients between pairs of 

measurements in the Analyze and Classify Measurements table. These coefficients quantify the strength and 

direction of the linear relationship between two variables, ranging from -1 (a perfect negative correlation) to 

+1 (a perfect positive correlation), with 0 indicating no correlation. 

Select the required table in the Analyze and Classify Measurements dialog and then click the Statistics 

button. Check the ‘Correlation matrix’ option in the Basic Statistics dialog, as shown below, to compute the 

correlation coefficients for the selected measurements. 

 

Basic Statistics dialog 

As shown below, each cell in the derived table of the correlation matrix contains the correlation coefficient of 

all pairs of values. 

 

Correlation matrix 
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The calculated Pearson correlation coefficients measure the strength and direction of the linear relationship 

between two variables, X and Y by normalizing the covariance by the product of their standard deviations as 

follows: correlation(X, Y) = covariance(X, Y) / (std(X) * std(Y)) 

Covariance(X, Y)… Measures how much two variables, X and Y, vary together. A positive covariance 

indicates that as X increases, Y tends to increase, and vice versa. A negative covariance suggests that as X 

increases, Y tends to decrease, and vice versa.  

std(X) and std(Y)… Represent the standard deviations of variables X and Y, respectively, which measure 

the spread or dispersion of data points around their respective means. 

15.2 Pick Tool 

The Pick tool added to the Analyze and Classify Measurements dialog, circled below, lets you make 

selections directly in views. You can pick the distinct objects of multi-ROIs in 2D and 3D views, or the faces 

and vertices of meshes and the edges and vertices of graphs in 3D views. The selected item will be 

highlighted and automatically scrolled to in the table. In addition, you can check the ‘Fit view to selection’ 

item, in which case the selection will be centered and maximized automatically in the workspace views. 

 

Pick tool in the Analyze and Classify Measurements dialog 

The following configured actions are available for the Pick tool. 

Action Key Mouse 

Activate the Pick Tool - Left mouse 

15.3 Opacity Controls for Multi-ROIs 

The opacity controls for multi-ROIs, circled below, let you set the opacity of the selected and unselected 

(complement) objects in the current scene views. 

 

Opacity controls in the Analyze and Classify Measurements dialog 

Selection opacity… This slider lets you set the opacity of all indexed objects that are selected — from not 

visible to fully opaque.  
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Complement opacity… This slider lets you set the opacity of all indexed objects that are not selected — 

from not visible to fully opaque. 

15.4 Multi-ROI Tools 

A couple of new tools for modifying the objects in multi-ROIs are now available in the Analyze and Classify 

Measurements dialog. These new options — Merge and Delete — let you merge selected labels and delete 

selected labels respectively and are circled below. 

 

15.5 Assign Unit 

Sometimes you may need to assign a unit to specific values. For example, the results of arithmetic 

operations are always set to ‘generic continuous’, which means that no measurement units are assigned. 

However, you can assign a unit to computed or other values as shown in the screenshot below. 

 

Analyze and Classify Measurements dialog 

You should note that the default units of lengths, areas, and volumes is meters, meters2, and meters3 

respectively, while the default unit of angles is radians. Whenever you assign a unit to scalar values, the 

default unit of the scalar values will be change, but the scalar values will not be changed. The value will only 

be updated to the units used to display the values. For example, if the stored scalar value is 0.0125 and you 

assign meters as the unit for the unit type ‘length’, then the values that appear will be 12.5 mm if the selected 

screen units are millimeters. 
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15.6 Export Table 

Two new options are available in this software release to export the labeled objects and their associated 

scalar values to a region of interest or multi-ROI. These options are circled on the following screenshot and 

explained below. 

 

Create multi-ROI from table… Click the Create Multi-ROI from Table  button to create a multi-ROI 

that only includes the labeled objects in the current table and their scalar values. In this case, the multi-ROI 

will have the same shape as the original object from which its scalar values were imported. 

Create ROI from table… Click the Create ROI from Table  button to create a region of interest that only 

includes the labeled voxels of all objects in the current table. In this case, the region of interest will have the 

same shape as the original objects from which its scalar values were imported. 
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16 CSV Export Preferences 

This software release includes new settings for exporting data in the CSV file format. You can now choose a 

character encoding system, as well as the option to include a byte-order mark (BOM) in the exported file. 

These options are available in the Miscellaneous preferences, as shown below. 

 

CSV export preferences 

The following options are now available for exporting data in the CSV file format. 

Setting Description 

Encoding 

Lets you choose the character encoding system — UTF-8, UTF-16, UTF-16BE, 

UTF-16LE, UTF-32, UTF-32BE, UTF-LE, or ISO-8859-1 — in which the data will 

be exported. 

NOTE UTF-8 is the standard encoding for most text files. 

Start with BOM marker 

If checked, a byte-order mark (BOM) will be added at the beginning of the text 

content in the exported file. A BOM is a sequence of 2 to 4 bytes at the start of a 

text file that serves as a header to indicate the file’s Unicode encoding. 

NOTE Although it is usually not required, some applications still use the BOM 

header to explicitly specify when files are encoded in UTF-8. 

NOTE Refer to the Wikipedia topic Byte-order mark for additional information about 

the definition and usages of byte-order marks. 

CSV export options  

https://en.wikipedia.org/wiki/Byte_order_mark
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17 Slice Analysis 

You should note that all 2D measurements available for multi-ROIs in the Compute Measurements dialog are 

now also available in the Slice Analysis panel for regions of interest. This lets you track and measure the 

characteristics of an object or objects in any orientation and over a number of slices. 

Right-click a 2D view and then choose Start Slice Analysis in the pop-up menu to open the Slice Analysis 

dialog, shown below. You can then choose the region of interest that you need to study, as well as the 

measurements that you need to compute, such as Area, Aspect Ratio, Feret Angle, Major Axis Length, and 

others. 

 

Slice Analysis panel 
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18 Histogram Analysis 

This software release includes the addition of the Otsu threshold as a statistic that can be computed and a 

modification for creating classes. 

18.1 Otsu Threshold 

The Otsu threshold separates pixels into two classes — foreground and background — and is determined by 

minimizing intra-class intensity variance, or equivalently, by maximizing inter-class variance. Applicable 

applications include generating contour meshes, applying threshold segmentations in single-material 

samples, painting with the brush tools, and filtering.  

For reference, this software release lets you compute the Otsu threshold value of your image data, as 

computed with the selected bin count. Open the Histogram Analysis dialog and then choose Otsu 

Threshold in the Statistics box to compute the value, as shown in the following screenshot. 

 

Histogram Analysis dialog 
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18.2 Class Creation 

In previous versions of Dragonfly 3D World, you could create classes by sequentially drawing ranges on 1D 

histograms in the Histogram Analysis dialog. In this software release, the workflow for creating classes on 1D 

and 2D histograms has been standardized and now requires you to create a new class for drawing ranges 

on 1D histograms. 

The option for adding classes when defining ranges on 1D histograms is circled in the following screenshot. 

 

Histogram Analysis dialog 
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19 Intensity Profiles 

As an update for version 2025.1, you can now plot the intensity profiles of regions of interest and multi-ROIs 

from rulers and paths. This can be used in cases in which you need to correlate the labeled voxels of a 

region of interest or multi-ROI with the intensity values of an image. As shown in the example below, the 

plotted profile shows the intensity values of a segmented image that correspond to the indexed labels of a 

multi-ROI. 

 

Intensity Profile dialog 

NOTE In most cases, you should choose ‘Proportional multi-scale’ for Y-axis scaling when plotting intensity profiles of 

image data along with regions of interest/multi-ROIs. 
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20 Exporting Intensity Counts 

In this software release you can export the raw intensity counts of your image data in the comma-separated 

values (*.CSV extension) file format instead of exporting binned values from a histogram. This option is 

available for all data types, including float.  

Right-click the required image data and then choose Export > Intensity Counts in the pop-up menu to 

export all intensity counts or to export all intensity counts within a mask. 

 

Export options 

NOTE You can select a mask in the Choose an ROI as Mask dialog if you only want to export the intensity counts of 

voxels within a specific area. 
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21 Vector Fields 

A new 3D Settings preference is available for vector fields to maximize the density of vectors that are 

rendered in 3D views. The preference ‘Increased vector field density’ is available in the Preferences dialog 

as shown and circled below. 

 

Preferences dialog 

The effect of applying the new preference compared to the previous implementation is shown in the following 

screenshots. You should notice that the distinct ‘row’ pattern is no longer evident in version 2025.1 whenever 

the vector field density is increased. 

 

Vectors fields in previous version (left) and with increased density in version 2025.1 (right) 
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22 Annotations 

A new snapping behaviour and other updates are available for annotations in this software release. 

22.1 Use Snapping 

This new option for the Points, Ruler, Angle, Path, and Arrow annotation tools lets you automatically snap 

control points to a mesh. This enables precise placement of control points that determine measurements with 

minimal effort. 

Check the Snap Mode option on the Annotate panel to enable snapping behaviour and to update the tools 

available for snapping. 

 

 

 

Annotate panel 

22.1.1 Snapping Preferences 

You can customize the snapping behaviour for the Annotate tools in the Preferences dialog. The preference 

‘Snapping tolerance (in screen percentage)’ lets you set a tolerance for snapping. 

 

Annotations preferences 
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22.2 Create Rulers Between Spheres 

For users who need to measure the distance between the centers of two spherical objects, such as ruby ball 

bars or ball forests used for CT calibration, this software release provides the option to create rulers that 

automatically span from the center of one sphere to the center of another. Do the following to create a ruler 

between spheres: 

• Create the required spheres.  

NOTE You can fit spheres to points that broadly define a spherical object. 

• Select the two spheres in the Data Properties and Settings panel, right-click, and then choose 

Create Ruler Between Spheres in the pop-up menu. 

A ruler is create automatically that starts at the center of the first sphere and ends at the center of 

the second sphere, as shown below. 

 

22.3 Arrows 

This software release includes the option to synchronize the position of arrows in all 2D views in a scene. As 

shown in the following screenshot, moving the head of an arrow will update the other 2D views automatically 

to the new location of the arrow if the setting ‘Synchronize position in all views’ is selected.  

 

Arrow position synchronized in all views 
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This new setting, circled on the following screenshot, is available on the Data Properties and Settings panel. 

 

Arrow properties 

You can set synchronization in all views as the default setting in the Annotations preferences. This setting — 

Sync position in all views — is available in the Annotations preferences as shown below. 

 

Annotations preferences 

  

 



 

 

 

    

Release Notes 

 

Dragonfly 3D World, Version 2025.1 
2025-09-11 

 Page 95 of 137 

    

22.4 Points Series 

Updates for Points series include creating planes from points, as well as applying floating captions. 

22.4.1 Create Planes From Points 

The option to create a plane from any points set that contains a minimum of three points is available in this 

software release. An example of a plane created from a series of points is shown below. 

 

Right-click a points set and then choose ‘Create a Plane from Points’ in the pop-up menu. The plane will be 

created from the ‘best fit’ of the points in the series. 

NOTE You will need to add a minimum of three points to the set to create a plane. 

22.4.2 Floating Captions 

You should note that floating captions are now available for points series. This option is available on the 

Data Properties and Settings panel, as shown below. 

   

Floating caption option for points 
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23 Shapes 

Updates for shapes included in this software release include extracting 3D projections from cylinders and 

spheres, as well as attaching a plane to a dataset. 

23.1 Extract 3D Projections from Cylinders and Spheres 

This software release provides the option to extract 3D projections of datasets from cylinders and spheres. 

This lets you inspect surfaces or sub-surfaces within a lower and upper radii that are translated from a 

cylindrical or spherical coordinate system to a rectangular coordinate system. In previous versions, only 2D 

projections could be extracted to examine surfaces extracted from cylinders and spheres. 

An example of a 3D projection extracted from a cylinder within a radius of 0.1 mm is shown below. 

 

3D projection extracted from a cylinder 

Do the following to extract a 3D projection from a cylinder or sphere: 

• Right-click the required sphere or cylinder and then choose Extract 3D Projection of Dataset in the 

pop-up menu. 

• Select a dataset in the Choose a Dataset to Unwrap dialog. 

• Select the required settings for the maximal and minimal radii and the step size in the Extract 3D 

Projection of Dataset dialog, as shown below. 

 



 

 

 

    

Release Notes 

 

Dragonfly 3D World, Version 2025.1 
2025-09-11 

 Page 97 of 137 

    

• Click OK to extract the 3D projection. 

NOTE You can perform segmentations on extracted projections and then re-wrap the projection into its original 

shape. 

23.2 Attach Plane 

Whenever you work with multiple objects, it can be difficult to manipulate planes. This software release 

provides the option to attach a visual plane to a selected object. In this case, the plane will be resized to the 

selected object, as shown below. 

 

Visual plane attached to an object 

Right-click the required plane and then choose Attach Visual Plane To in the pop-up menu. You can 

choose the object that want to attach the visual plane to in the ‘Choose the Object to Attach To’ dialog, as 

shown below. 

 

Choose the Object to Attach To dialog  
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24 Translate/Rotate Tools 

For image registration and other purposes, this software release provides an update for the Translate/Rotate 

tools. You can now choose an angle of rotation that will be applied to rotate selected objects, as well as the 

step size that will be applied to translate selected objects. 

Do the following to rotate selected objects by a set angle: 

• Click the Displace tool on the Translate/Rotate panel and then right-click the Rotate tool handle. 

Choose ‘Set Rotation’ in the pop-up menu, as shown below. 

 

NOTE In this case, the rotation will be applied from the pivot point. 

or 

Right-click the required 2D view and then choose Translate/Rotate Selected Objects > Rotate in 

the pop-up menu, as shown below. 

 

NOTE In this case, the rotation will be applied from the center of the view. 

• Choose the required angle of rotation, which can be negative or positive, in the Rotate dialog. 

 

• Click OK to rotate the selected object(s).  
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Do the following to translate selected objects by a set step: 

• Click the Displace tool on the Translate/Rotate panel and then right-click the Rotate tool handle. 

Choose ‘Set Translation’ in the pop-up menu, as shown below. 

 

or 

Right-click the required 2D view and then choose Translate/Rotate Selected Objects > Translate 

in the pop-up menu, as shown below. 

 

• Choose the required horizontal and/or vertical translation steps, which can be negative or positive, in 

the Translate dialog. 

 

• Click OK to translate the selected object(s) by the set amount(s). 
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25 Views 

A number of updates for the workspace views are available in this software release. 

25.1 View at 100% 

A new setting for 2D views — View at 100% (1:1 Pixel Ratio) — is available in this software release to 

provide the most accurate view. In this mode, each image pixel will be displayed by one monitor pixel. At 

other zoom settings, image pixels may be interpolated to a different number of monitor pixels. 

The 100% zoom setting is available in the 2D view drop-down menu. You can set any 2D view to 100% 

zoom in the Dragonfly 3D World workspace and in the Image Filtering context, as shown below. 

 

2D view set at 100% in Image Filtering (on right) 

NOTE Viewing an image at 100% zoom without interpolation can be important for image processing because it lets you 

accurately analyze individual pixels and identify potential issues like noise, sharpness, pixelation, or artifacts. This 

can help ensure that you are making precise adjustments based on the actual pixel data without any smoothing 

effects. 
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25.2 Show 2D View Planes Permanently 

For inspection workflows or to simply examine your image data, you may want to show the 2D view planes 

permanently in 3D views. This option — Show 2D View Plane(s) Permanently — is available in the 3D view 

pop-up menu as shown below. 

 

3D view pop-up menu 

As shown below, the 2D view planes will remain visible in the 3D view after the 3D cursor is manipulated in 

any of the 2D views contained in the scene or if a 2D view is scrolled or rotated with the Yaw or Pitch text 

annotations. 

 

Planes shown permanently in a 3D view  
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25.3 Setting the Visibility of Multiple Objects 

Whenever you work with a large number of objects, you may want to synchronize the visibility of selections 

so that objects are either visible or hidden. 

As shown below, clicking the Eye icon for any object within a selected group on the Data Properties and 

Settings panel will synchronize the visibility of all objects in the group to the setting applied to the clicked 

object. In addition, clicking the 3D icon will synchronize the visibility of all objects in the group in the 3D view 

to the setting applied to the clicked object. 

 

Setting the visibility of multiple objects 

NOTE The visibility of the selected classes of multi-ROIs is also synchronized in the Classes and scalar information box 

in this software release. 
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26 Auto Executor 

This software release includes the production release of Dragonfly 3D World’s Auto Executor, which can be 

configured to automatically process data sent to a polled directory with a selected macro. The settings that 

need to be configured are available on the Auto Executor panel. These settings include the directory to poll 

for new scan data, the type of data to process, the required monitoring period, and the macro that will be 

executed within the workflow. 

Choose Utilities > Auto Executor on the menu bar to open the Auto Executor panel, shown below. 

 

Auto Executor panel 

NOTE The Auto Executor is separately licensed feature for Dragonfly 3D World. Commercial and non-commercial users 

will need an additional license to run the AE. Contact sales.dragonfly@comet.tech for more information and 

pricing.  

mailto:sales.dragonfly@comet.tech
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The following settings and options are available on the Auto Executor panel. 

Setting Icon Description 

Start 
 

Click to start processing new data sent to the polled directory. 

NOTE The status of the macro is shown at the bottom of the Auto Macro 

Executor panel, as shown in the example below. 

 

Auto start with Dragonfly -- 
If checked, the macro will start automatically whenever Dragonfly is launched. 

NOTE All other operations will not be available when the macro is running. 

Directory -- 

Lets you select the directory that will be polled for new data to process. For 

example, D:/folder_to_poll.  

Images sent to new folders within this directory will be processed. For example, 

D:/folder_to_poll/yyyy.mm.dd-hh.mm.ss. 

File extension -- 

Lets you select the type of file or files that will be searched for in the polled 

directory. 

Recursive… If checked, the application will search deeper and deeper into 

folders until it finds the selected data type to process. 

Check every xx minutes -- 
Determines the frequency, in minutes, at which the selected directory will be 

polled. 

Image stack complete -- 

Lets you select the criteria that indicates when all image data has been 

received. 

Check for file… If selected, the image stack will be considered complete when 

a file with the designated file name is pushed to the polled directory. For 

example, ‘ready.txt’. 

You should note that the ‘Check for file’ option is usually selected when the 

number of image files is unknown. For example, in cases in which data is 

saved as single TIFF or PNG files that are part of an image stack. 

After xx images… If selected, the image stack will be considered complete 

when a set number of image files are available in the polled directory. 

Exclude directory with 

string (comma separated) 
-- 

Lets you exclude a directory or directories automatically. 

For example, ‘.lock’ and ‘_tmp’. 

Add macro operation 
 

Lets you add macro files to the current processing operation. 

Delete selected operation 
 

Lets you delete the selected operation. 

Export operation stack 
 

Lets you export the current operation stack in the JSON file format (*.json 

extension). 

Import operation stack 
 

Lets you import an exported operation stack. 

Auto Executor settings 
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27 Macro Recorder 

Updates available for Dragonfly’s Macro Recorder include added items for managing and sharing macros. 

Choose Utilities > Macro Player on the menu bar to open the Macro Player, shown below. 

 

Macro Player dialog 

The following added items are available for managing macros: 

Setting  Description 

Rename macro 
 

Opens the Rename Macro dialog, in which you can rename the currently 

selected macro. 

Import macro to current 

user’s folder  
Lets you import a saved macro into the default macro folder for the current 

user or all users. 

Open folder 
 

Opens the folder that contains the currently selected macro. 

Share 
 

Lets you share the currently selected macro on Dragonfly Social. 

Macro Player controls 
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28 Picture-In-Picture Mode 

For 2D animations and screenshots, this software release provides a ‘Picture-in-Picture’ mode in which an 

overlay of the 3D view can be added to any 2D view. The overlay can include the 2D view plane(s) and can 

be repositioned and resized in the 2D view. Lighting and other effects applied to the 3D view will also appear 

in the added overlay, as shown in the following screenshot. 

 

2D view in Picture-in-Picture mode 

Adjust the 3D view as required and then click the PiP button on the Overlays panel, as shown below, to add 

a 3D view overlay to the current 2D view. 

 

Overlays panel 
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29 Movie Maker 

Advanced animation options for all key frames, starting the Movie Maker with or without a saved timeline, 

and saving videos in the MP4 file format are available in this software release for animated sequences. 

29.1 Advanced Animation Options 

For advanced users, this software release provides the option to activate or deactivate the key value of any 

selected property, such as the camera, lighting, opacities, and others, for all key frames on the timeline. This 

option is available for applicable properties in the Advance Animation Options dialog. 

As shown below, you can activate or deactivate the key value for properties by checking or unchecking the 

Property Name checkboxes, as shown below. 

 

Advanced Animation Options dialog 

The effect of checking or unchecking the activation checkboxes on the left side of the Advanced Animation 

Options dialog is as follows:  

If checked… The selected property, such as lighting, global opacity, edge contrast, or other, will be applied 

as per the key value set for each key frame. This means that the property’s key value for each key frame on 

the timeline will be applied when the animation is played and recorded. You should note that key values can 

be set in the Advanced Animation Options dialog, as well as in the Scene’s Views Properties and the Data 

Properties and Settings panels. 

If unchecked… The selected property, such as lighting, global opacity, edge contrast, or other, will be 

deactivated as per the key value of the current key frame. This means that the property’s key value for each 

key frame on the timeline will not be applied when the animation is played and recorded. 
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29.2 Starting the Movie Maker 

In cases in which you load a session with a saved timeline, you can choose to start the Movie Maker with the 

timeline saved in the session file or you can choose to start a new Movie Maker without the saved timeline. 

These options are available in the 3D view pop-up menu, as shown below. 

 

3D view pop-up menu 

Start Movie Maker With Saved Timeline… Starts the Movie Maker with the timeline saved in the currently 

open session file. In this case, the keyframes you created in the saved session will appear on the timeline. 

Start New Movie Maker… Starts a new Movie Maker with a blank timeline. In this case, any keyframes you 

created in the saved session will not appear in the Movie Maker. 

29.3 Save as MP4 

This software release includes the option to save the animated sequences you create in the MP4 (*.mp4 

extension) file format. MP4 is an international standard that works with a vast range of devices and, when 

compared to other video file types, MP4 files are typically more compressed. However, this file format has a 

high post-compression video quality, which means that any loss in video quality during playback is usually 

minimal. 

The option to choose a file format for exporting animations is available in the Export as Video File dialog, as 

shown below. 

 

Save options in the Export as Video File dialog 
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30 Screen Recorder 

A number of updates are available in this software release for Dragonfly’s Screen Recorder, which can be 

used to make videos that illustrate findings, new workflows, and analysis techniques. 

Choose Utilities > Screen Recorder on the menu bar to open the Screen Recorder dialog, shown below. 

 

Screen Recorder 

Updates for the Screen Recorder include: 

• The option to automatically pause a recording whenever a Progress dialog appears onscreen and to 

then resume recording when processing is complete. 

• The option to choose the microphone that will be used for recording audio. 

 

• The option to select the region to record — Full Screen, Full Application, or Custom Area. 
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31 Bone Analysis Wizard 

Updates in this software release for the Bone Analysis wizard include a refreshed workspace, an additional 

opacity control for the Kohler segmentation method, and new options for computing global measurements. 

31.1 Workspace Update 

As part of the updates for Dragonfly 3D World’s Bone Analysis wizard, the tools at the top of the workspace 

were grouped within boxes according to the function. As shown below, all of the manipulate, flip/rotate, 

annotate, and shape tools are now grouped within collapsible boxes. 

 

Bone Analysis workspace 
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31.2 Opacity Control for Kohler Segmentation Method 

The Bone Analysis wizard provides two methods to segment cortical and trabecular bone — Buie and 

Kohler. As an update for the Kohler method, you can now adjust the opacity of highlight that defines the 

threshold for separating cortical and trabecular bone. 

 

Threshold and Opacity sliders for Kohler method 

31.3 Updates for Global Measurements 

To help accelerate measurement workflows, this software release includes the option to update the volume 

of computation for multiple indices at the same time. As shown below, you can apply a volume of 

computation — the default computation box, full volume, or any custom box — to all selected items in the 

drop-menu, as shown below. 

 

Global Measurements dialog  
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32 Automated Porosity Segmentations 

A new option for segmenting pores and cavities, as well as an update for automated porosity segmentations 

using the Otsu threshold and Sobel filtering, are available in this software release.  

32.1 Ambient Occlusion (AO) Fields 

Used for segmenting pores and cavities, the newly added ambient occlusion (AO) algorithm calculates a 

scalar value for each voxel of a dataset, which represents the degree to which it is ‘occluded’ from ambient 

light, to distinguish pores and cavities from the surrounding material and background. An example of a pore 

network segmentation done with the AO algorithm is shown below. 

 

Pore network segmented with AO fields 

Right-click a 3D image or region of interest and then choose Porosity Segmentation with AO Fields to 

open the Ambient Occlusion Fields Segmentation dialog. You can then enter the required settings in the 

dialog to segment the pores and cavities in the selected object. 

 

Ambient Occlusion Fields Segmentation dialog 

NOTE If you are applying the AO algorithm to a region of interest, you must label the material within the image. You 

should also note that the setting ‘Threshold’ is not available for regions of interest. 
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32.2 Automated Porosity Segmentation Methods 

Dragonfly 3D World provides automated porosity segmentation methods to analyze closed pores quickly and 

accurately in single-material samples, such as castings. You can now execute all methods in a single click, 

as shown in the screenshot below. 

 

Pop-up menu items for automated porosity segmentations 

The output of all automated porosity segmentations is a series of multi-ROIs, as shown below, with labels for 

the Exterior, Matrix, and Pores. Any measurements related to the labels of the generated multi-ROIs can be 

viewed in the ‘Classes and scalar information’ box. 

 

Generated automated porosity segmentation outputs  
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33 Open Fiber Segmentation 

Updates for the Open Fiber Segmentation module, which lets you extract individual fibers from datasets of 

short fiber reinforced composites, are available in this software release. Choose Workflows > Open Fiber 

Segmentation on the menu bar to open the module, shown below. 

 

Open Fiber Segmentation panel 

Changes include the following: 

Min fiber length… This parameter, which is the minimum value that the algorithm will accept as a fiber, now 

uses the default length units instead of pixels. 

Desired output… Two options — Segmented fibers and Centerline fibers — can be selected either 

separately or in combination as the desired output. The output multi-ROI can be the extracted individual 

fibers and/or a multi-ROI of extracted centerlines of the individual fibers. 
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33.1 PuMA (Porous Microstructure Analysis) 

To help support different workflow needs, this software release includes ‘Precision’ settings for computing 

outputs in the PuMA (Porous Microstructure Analysis) dialog. As shown in the following screenshot, you can 

choose from the fastest computation with lowest accuracy to highest accuracy with slowest computation. 

 

33.2 Pore Network Modeling 

You should note that the version of OpenPNM implemented in Dragonfly 3D World was updated to 3.0 for 

this software release. Choose Workflows > Pore Network Modeling on the menu bar to open the 

OpenPNM tab on the left sidebar. This extension provides porous media researchers with a ready-made 

framework for performing a wide range of pore network simulations. 

NOTE Refer to https://pmeal.com/posts/2022-10-10/ for information about the updates available in version 3.0 of 

OpenPNM. 

  

https://pmeal.com/posts/2022-10-10/
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34 Additional File Support 

To make Dragonfly 3D World more accessible to a wider range of data types, this software release includes 

support for additional proprietary file formats exported from leading hardware manufacturers. 

34.1 Support for XRV Files 

This software release includes support for seamlessly integrating volume and multi-volume scans with 

metadata handling from Yxlon Geminy systems directly into Dragonfly 3D World. This allows users to directly 

compare the resulting volumes from different X-ray acquisition setups side-by-side in 3D World. Multiple sub-

scan volumes exported in the XRV (*.xrv extension) file format can be loaded as a single stitched volume or 

as separate volumes. 

Stitch files… You can automatically load and stitch multi-volume scans from the Command Prompt dialog 

using ‘load’ or ‘load_data’. You can also right-click the required XRV file and then choose to open the file 

with the ‘Dragonfly.exe’ for version 2025.1. 

Load as single files… You can load the scans in XRV files separately with Dragonfly’s Image Loader. In 

this case, you can choose which files will be loaded (as shown below on the left), as well as the image 

settings, such as sampling and convert to 16 bits, for each scan (as shown below on the right). 

   

Import Image dialog 

34.2 Support for Bruker Files 

This software release includes support for loading image files exported from Bruker microCT and 3D X-ray 

microscopy systems. This includes extracting image pixel sizes from log files (*.log file extension) when 

loading image stacks. 

Choose File > Import Image Files to open the Image Loader and then do one of the following. 

• Add the BMP, PNG, or TIFF files that you want to load.  

• Choose the folder containing the files that you want to load. 

• Add the .log file that is in the same directory as the BMP, PNG, or TIFF files that you want to load. 
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34.3 Support for Nikon Files 

This software release includes support for opening reconstructed CT volume files exported from Nikon 

imaging systems as *.vol or *.raw files. 

Choose File > Import Image Files to open the Image Loader and then add the *.nhdr file that is in the same 

directory as the *.vol or *.raw file that you want to load. This header file contains all of the information 

required to open the CT volume files correctly. 

 

NOTE Nikon header files with a *.nhdr file extension were previously only written whenever files were converted from 

floating point to 16-bit and 8-bit data. This file is now written for all volumes. 

34.4 Support for North Star Imaging Files 

This software release includes support for opening reconstructed datasets exported from North Star Imaging 

(NSI) systems with the *.nsihdr and *.nsivol file extensions. 

Choose File > Import Image Files to open the Image Loader and then add the *.nsihdr or *nsivol file that 

you want to load. 

NOTE Support for loading NSI files is only available for the Windows version of Dragonfly 3D World. 

35 Deriving, Resampling, and Extracting Datasets 

This software release provides interpolation options — Point, Linear, and Tricubic — for creating datasets 

derived from a view, extracted from a shape, or whose geometry was resampled from another dataset. 

These interpolation options are also available for datasets extracted from a shape. 

   

Choose Interpolation dialog  
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36 Auto Load Session Files 

This software release includes the option to automatically load a session file whenever Dragonfly 3D World is 

launched or whenever a new session is created. As shown below, creating a session file with only an image 

overlay lets you display a company or institutional logo in the workspace without having to import it 

repeatedly. 

 

3D World workspace with an image overlay 

The option to auto load a session file is available in the Miscellaneous preferences, as shown below. 

 

Miscellaneous preferences  
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37 Dragonfly Social 

You should notice improvements for Dragonfly Social that makes it more user-friendly, engaging, and 

resourceful — which should help you to get the most out of your interactions, discussions, and shared 

resources. You should also note that Dragonfly Social will now appear in your default browser instead of the 

custom Chromium browser used previously when accessed from Dragonfly 3D World. 

Changes for Dragonfly Social include: 

• A refreshed interface for easier navigation. 

• Enhanced spaces to help you connect, learn, and collaborate. 

• Easy sharing of deep models (see Sharing Deep Models). 

• A first implementation of a chatbot, which is designed to answer questions about Dragonfly using our 

product knowledge base. To start a post, click the Chatbot Beta Testing link on the navigation panel 

and then enter your message in the Create a post box. When processing your request is done, you can 

review the information generated by the chatbot, as shown below. 
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• Improved resources for better access to tutorials, datasets, and discussions. A new tutorial series is now 

available with videos covering fundamental topics to get you started. And that is just the beginning. We 

will be adding more tutorials regularly to support your journey. 
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38 Checking for Updates 

All Dragonfly customers receive notification of new software releases, which contain new features, 

performance improvements, bug fixes, and other changes. You can also check for new releases on a regular 

basis to ensure that your version of Dragonfly has the latest updates. Updates can be downloaded and 

installed as described below for systems running online, as well as for offline systems. 

NOTE Commercial users must have a valid Maintenance and Support plan to be eligible for an updated version. Non-

commercial users must have a current non-commercial license. 

38.1 Updating Online Systems 

Do the following to check for and install an update for a system connected to the internet: 

• Save your work and create a new session, recommended. 

NOTE Dragonfly 3D World cannot be updated if it is running. It will close automatically during the 

installation process. 

• Choose Help > Check for Updates on the menu bar. 

A message appears with the results of comparing the version installed on your system with the 

current version that is available. 

  

• Do one of the following if an update is available: 

o Click the Download and Install button if you want to update your system. 

If you chose to update your system, a Zip file with the installer will be downloaded and then 

unzipped automatically. Click Yes if the User Account Control dialog appears. Dragonfly will 

close and the Setup Wizard will appear. Follow the onscreen instructions to install the update. 

o Click Cancel if you want to update your system at another time or not at all. 
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38.2 Offline Updates 

Do the following to check for and install an update for an offline system: 

• Choose Help > Check for Updates on the menu bar. 

The Check for Updates dialog appears onscreen with a QR code. 

 

• Open the Camera app or Code Scanner on your smart phone. 

• Hold your device so that the QR code appears in the viewfinder. A link will be shown when the 

device recognizes the QR code. 

• Tap the link to open the notification associated with the QR code. 

• Do the following if an update is available: 

o Enter and send your email. You will then receive an email with a download link. 

o Download the Zip file with the installer to a portable device, such as a USB key. 

o Unzip the file you downloaded on your Dragonfly workstation and then run the installer. 
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38.3 License Keys 

You should note that license keys are in pairs — activation keys that you receive to activate licensed 

features and computer-bound keys that are activated for each licensed feature. The main advantage of this 

arrangement is to allow seamless offline activations.  

Choose Help > Activate Product on the menu bar to view your activation and computer-bound keys in the 

Activate Product dialog, shown below. 

 

Activate Product dialog 

39 Location of Python Distribution and Code 

The location of the extracted Python distribution and Python code was changed for this software release as 

follows: 

Location of Python distribution… Is now copied to ‘%installation_folder%\Python_env’. It was previously 

available in the directory ‘%ProgramData%\ORS\Dragonflyxxxx.x\Anaconda3’. 

Location of Python code… Is now copied to ‘%installation_folder%\python’. It was previously available in 

the directory ‘%ProgramData%\ORS\Dragonflyxxxx.x\python’.  
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40 Menu Bar Changes 

The following new items are available on the menu bar in Dragonfly 3D World 2025.1. Other changes are 

also listed here. 

40.1 File Menu 

The following changes, listed below, were implemented in the File menu. 

Item Description 

Import Points from CSV 
Lets you import a points set that was exported from Dragonfly 3D World in the 

comma-separated values (*.CSV extension) file format. 

Reset to Recommended 

Workspace 

Resets the workspace to the arrangement recommended by the Dragonfly team. You 

can save the recommended workspace as the default one by choosing File > Save as 

Default Workspace on the menu bar. 

Reset to Pre-Configured 

Workspace 
Resets the workspace without any configured arrangement of the panels. 

Recent Objects 

Displays a list of recently imported object files (*.ORSObject extension). You can 

select an item from the list to import it. 

 

File menu 

40.2 Workflows Menu 

The following changes, listed below, were implemented in the Workflows menu. 

Item Description 

Scalar Values Interpolator 

Opens the Scalar Values Interpolator dialog, shown below, in which you can produce 

smooth surfaces from the scalar values in graphs and meshes. 

   

Workflows menu 
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40.3 Artificial Intelligence Menu 

The following changes, listed below, were implemented in the Artificial Intelligence menu. 

Item Description 

Custom Deep Model 

Architectures 

This software release includes a new custom deep model architecture for object 

classification as well as updates for the Noise2Void and YOLO custom deep model 

architectures. 

Noise2Void… Opens the Noise2Void dialog, which provides a custom deep model 

architecture for denoising (see Noise2Void for Denoising). 

Classification… Opens the Classification dialog, which provides access to the custom 

deep model architecture EfficientNet for unparalleled efficiency and accuracy for image 

classification tasks (see Deep Model(s) for Image Classification). 

YOLOv7… Opens the YOLOv7 dialog, which provides a custom deep model 

architecture for object detection (see YOLO (You Only Look Once) for Object 

Detection). 

AI Visual Assistant 
Opens the AI Visual Assistant dialog, in which you can enter prompts to locate, 

identify, and count distinct objects in a 2D view (see AI Visual Assistant). 

Artificial Intelligence menu 

40.4 Utilities Menu 

The following changes, listed below, were implemented in the Utilities menu. 

Item Description 

Auto Executor 

Opens the Auto Executor panel on the right sidebar, which can be configured to 

automatically process data sent to a polled directory with a selected macro (see Auto 

Executor). 

Utilities menu 
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41 Changes to Contextual Menus 

The following changes for the contextual menus available in the Data Properties and Settings panel and for 

the 2D and 3D views contextual menus are implemented in Dragonfly 3D World 2025.1. 

41.1 Dataset Contextual Menu 

The items listed below are now available in the Dataset pop-up menu. 

Item Description 

With World Axis 

Available in the Align sub-menu, this new item lets you align images orthogonally 

to world axis coordinates. For cases in which an image was extracted from a shape 

that was not orthogonal to the imaging plane. 

Automated Porosity Segmentation 

The original items from version 2024.1 were renamed and a new item was added 

that executes all automated porosity segmentations sequentially (see Automated 

Porosity Segmentation Methods). 

Porosity Segmentation with AO 

Fields 

Lets you segment pores and cavities from the surrounding material and 

background (see Ambient Occlusion (AO) Fields). 

Surface Determination 
Opens the Surface Determination panel, in which you can generate high precision 

meshes (see Surface Determination Tool). 

Anatomical Structures 

Segmentation 

Opens the Anatomical Structures Segmentation dialog, in which you can fully 

segment anatomical structures in both CT and MRI images (see Anatomical 

Structures Segmentation). 

Intensity Counts 

Available in the Export sub-menu, this new item lets you export the raw intensity 

counts of image data in the comma-separated values (*.CSV extension) file format 

instead of exporting binned values from a histogram (see Exporting Intensity 

Counts). 

Dataset pop-up menu 

41.2 ROI Contextual Menu 

The items listed below are now available in the ROI pop-up menu. You should note that some refactoring 

was applied to streamline the ROI contextual menu. 

Item Description 

Process Islands 2D 
Available in the Refine Region of Interest sub-menu, this new item lets you process 

islands slice-by-slice in the Z axis (see Process Islands in 2D).  

Connected Components 2D 
Lets you create new multi-ROIs of connected components on a slice-by-slice basis 

in the Z axis (see Connected Components 2D). 

Adaptive Watershed 2D 
Lets you apply the Adaptive Watershed algorithm on a slice-by-slice basis in the Z-

axis (see Adaptive Watershed 2D). 

Skeletonize ROI 2D 
Lets you skeletonize a region of interest on a slice-by-slice basis in the Z-axis (see 

Skeletonize ROI 2D). 
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Item Description 

Skeletonize and Prune ROI 
Lets you extract a selected number of paths that will be included in the graph 

generated from a skeletonized region of interest (see Skeletonize and Prune ROI). 

2D Distance Map 

Signed 2D Distance Map 

Available in the Create Mapping Of sub-menu, these new items let you compute 

distance maps on a slice-by-slice basis in the Z-axis (see 2D Distance Maps). 

Create Sparse Graph 2D 

Create Dense Graph 2D 

Available in the 3D Modeling sub-menu, these new items let you create graphs on 

a slice-by-slice basis in the Z-axis (see 2D Graphs). 

Create Voxel Based Dense Graph 

This new item in the 3D Modeling sub-menu lets you create a graph in which every 

single voxel of the skeletonized and pruned region of interest has a corresponding 

vertex. In contrast, a dense graph does not necessarily put a vertex at every voxel 

position. 

ROI pop-up menu 

41.3 Multi-ROI Contextual Menus 

The items listed below are now available in the multi-ROI pop-up menu. You should note that some 

refactoring was applied to streamline the multi-ROI contextual menu. 

Item Description 

Connected Components 2D 
Lets you create new multi-ROIs of connected components on a slice-by-slice basis 

in the Z axis (see Connected Components 2D). 

Compute Watershed 2D 

Watershed Transform 2D 

Are 2D versions of the Compute Watershed and Watershed Transform that are 

applied on a slice-by-slice basis in the Z-axis (see Compute Watershed 2D and 

Watershed Transform 2D). 

Compute Watershed 2D with 

Plane 

Lets you choose an orientation, or ‘plane’, to apply the Compute Watershed 2D 

algorithm. The result is a watershed applied to a single slice in the selected 

orientation (see Compute Watershed 2D with Plane). 

Create Dense Graph from Multi-

ROI 
Lets you create a dense graph from multi-ROIs. 

Create Colored Multi-ROI from 

RGB Channels 

Lets you convert the red-green-blue channels of imported color images to multi-

ROIs in which each voxel is assigned a unique color that matches the color image 

(see Create Colored Multi-ROI From RGB Channels). 

Multi-ROI pop-up menu 
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The items listed below are now available in the Classes and Scalar Information pop-up menu. 

Item Description 

Launch Split Tool 
Opens the Multi-ROI Split Tool dialog, in which you can separate clustered objects 

(see Split Tool). 

Create a Bounding Box from 

Class 

Automatically creates a box that encloses the labeled voxels of the selected class 

(see Create Boxes From Classes). 

Create Bounding Boxes for Each 

Class 

Automatically creates a series of boxes that enclose the labeled voxels of each 

selected class (see Create Boxes From Classes). 

Create a Bounding Box from 

Classes 

Automatically creates a box that encloses the labeled voxels of all selected classes 

(see Create Boxes From Classes). 

Export Class as an Optimized 

Thickness Mesh 
Exports the selected class as an optimized thickness mesh (see Optimal Meshes). 

Classes and scalar information pop-up menu 

41.4 Meshes Contextual Menu 

The items listed below are now available in the Meshes pop-up menu. 

Item Description 

Fit Shape from Vertices 
Lets you create a cylinder, plane, or sphere that is fitted to the vertices of the 

selected mesh. 

Meshes pop-up menu 

41.5 Shapes Contextual Menu 

The items listed below are now available in the Shapes pop-up menu. 

Item Description 

Tools 
The new tools let you cut meshes within or outside of boxes (see Mesh Tools). 

NOTE Available for boxes only. 

Extract 3D Projection of Dataset 

Lets you extract 3D projections of datasets from cylinders and spheres (see Extract 

3D Projections from Cylinders and Spheres). 

NOTE Available for spheres and cylinders only. 

Create Ruler Between Spheres 
Lets you create a ruler between the centers of two selected spheres (see Create 

Rulers Between Spheres). 

Shapes pop-up menu 
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41.6 Annotations Contextual Menu 

The items listed below are now available in the annotations pop-up menu. 

Item Description 

Look at Annotation in All 

Views 

Automatically scrolls each 2D view in the current scene to the location of the selected 

arrow or the first point in the selected points set without changing the orientation of the 

views. This means that if the default MPR views are available in the scene, then the 

annotation will be shown in the XY, XZ, and YZ orientations. 

Create a Plane from Points 

Lets you create planes from any points set that contains a minimum of three points 

(see Create Planes From Points). 

NOTE Available for points only. 

Create an ROI from an 

Annotation 

Lets you create a region of interest from annotations, as described below. 

Points… The region of interest will be a series of connected lines.  

Regions… The region of interest will the filled. 

Rulers, angles, paths… The region of interest will be a single line. 

Annotations pop-up menu 

41.7 2D Views Contextual Menu 

The items listed below are now available in the 2D views pop-up menu. 

Item Description 

View at 100% (1:1 Pixel Ratio) 
If selected, each image pixel will be displayed by one monitor pixel (see View at 

100%). 

Translate/Rotate Selected 

Objects 

Lets you translate or rotate selected objects by set step sizes (see Translate/Rotate 

Tools). 

2D views pop-up menu 

41.8 3D Views Contextual Menu 

The items listed below are now available in the 3D view pop-up menu. 

Item Description 

Show 2D View Plane(s) 

Permanently 

If selected, 2D view planes will remain visible in the 3D view after the 3D cursor is 

manipulated in any of the 2D views or if a 2D view is scrolled or rotated with the Yaw 

or Pitch text annotations (see Show 2D View Planes Permanently). 

Start Movie Maker With Saved 

Timeline 

Starts the Movie Maker with the timeline saved in the currently loaded session file. In 

this case, the keyframes you created in the saved session will appear on the timeline. 

Start New Movie Maker 
Starts a new Movie Maker with a blank timeline. In this case, any keyframes you 

created in the loaded saved session will not appear in the Movie Maker. 

3D views pop-up menu  
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42 Preferences Changes 

Changes implemented for setting the application preferences are listed in this topic. Click Preferences on the 

Status bar or choose File > Preferences on the Menu bar to open the Preferences dialog. 

42.1 Views Preferences 

The following changes were implemented for the Views preferences. 

42.1.1 2D Settings 

Changes to the 2D Settings preferences are indicated in the following table. 

Item Description 

Show 3D cursor in maximized 

view 

This new 2D Settings preference lets you choose to keep the crosshairs of the 3D 

cursor visible in maximized 2D views. 

 

2D Settings preferences 
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42.1.2 3D Settings 

Changes to the 3D Settings preferences are indicated in the following table. 

Item Description 

Default camera view 

This new 3D Settings preference lets you choose a default camera view — From +/-X, 

From +/-Y, or From +-/Z — for 3D views. The camera view options are available in the 

Default camera view drop-menu, as shown below. 

 

Increased vector field density Maximizes the density of vectors that are rendered in 3D views (see Vector Fields). 

3D Settings preferences 

42.1.3 Annotations 

Changes to the Annotations preferences are indicated in the following table. 

Item Description 

Snapping tolerance (in screen 

percentage) 

Lets you set a tolerance, in screen percentage, for the snapping behaviour of 

applicable Annotate tools (see Use Snapping). 

Synchronize position in all 

views 

This new Annotations preference for arrows lets you choose to automatically 

synchronize the position of the arrows on all views of the current scene (see Arrows). 

Annotations preferences  
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42.2 Miscellaneous Preferences 

Changes for the Miscellaneous preferences are indicated in the following table. 

Item Description 

Use GPGPU acceleration 

(when available) 

If selected, applicable operations will run within the GPGPU framework (see 

GPGPU Acceleration). 

Auto-load session file 

Lets you choose a session file that will be loaded automatically each time that 

Dragonfly 3D World is launched or whenever a new session is created (see Auto 

Load Session Files). 

CSV Export 

Lets you choose a character encoding system, as well as the option to include a 

byte-order mark (BOM) in exported CSV files. Refer to the topic CSV Export 

Preferences for additional information about these settings. 

 

Miscellaneous preferences 

42.3 Deep Learning Preferences 

Changes for the Deep Learning preferences, including removed items, are described in the following table. 

Item Description 

Checkpoint cache 

Now includes the option to set the number of model checkpoints that will be saved 

when the option ‘Enable checkpoint cache’ is selected. 

 

Compile deep models for faster 

inference 

This item for compiling deep models with TensorFlow-TensorRT (TF-TRT) was 

removed with the migration to PyTorch for deep learning applications. 

Execute Deep Learning tasks in 

an external process 

This preference for executing deep learning tasks in an external process was 

removed for this version since PyTorch releases GPU memory at the end of 

training or inference. 

Deep Learning preferences  
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43 System Requirements 

This software release supports the base system requirements for Windows and Linux. However, if you want 

to run PyTorch with the latest CUDA version, you might need to update your installed graphics driver before 

installing Dragonfly 3D World 2025.1. See Deep Learning Requirements for 2025.1 for information about 

checking the installed graphics driver and CUDA version on your system. 

NOTE Go to https://dragonfly.comet.tech/en/getting-started for system recommendations to fully experience all the 

benefits and capabilities of Dragonfly 3D World. 

44 Third-Party Packages 

You should note the changes for the third-party packages listed below. 

Item Version 2025.1 Previous Version (2024.1) 

PyTorch 2.7.1 Not applicable 

Qt 6.7.1 6.4.2 

Python 3.10.13 3.10.12 

PuMA 3.2.0 3.2.0 

Netgen/NGSolve 6.2.2301 6.2.2202 

Third-party packages 

  

https://dragonfly.comet.tech/en/getting-started
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45 Publicly Available Source Code 

Users can freely download and examine the source code of the following. 

45.1 PyTorch 

PyTorch is a machine learning library based on the Torch library, which was originally developed by Meta AI 

and is now part of the Linux Foundation umbrella. It is recognized as one of the two most popular machine 

learning libraries alongside TensorFlow and is distributed as open-source software released under the 

modified BSD license. PyTorch offers a comprehensive collection of building blocks for neural networks, 

including various layers and activation functions, enabling the construction of complex models. 

You can freely download and examine the PyTorch source code from: https://pytorch.org/. 

45.2 Qt 

Dragonfly is designed and developed with Qt, which is a free and open-source toolkit for creating graphical 

user interfaces and cross-platform applications. Qt is developed by The Qt Company, a publicly listed 

company, and is available under both commercial licenses and open-source GPL 2.0, GPL 3.0, and LGPL 

3.0 licenses. 

Users can freely download and examine the Qt source code from: https://download.qt.io/official_releases/qt/. 

45.3 Porous Microstructure Analysis (PuMA) 

The Porous Microstructure Analysis (PuMA) software integrated in Dragonfly was developed by researchers 

at NASA to compute effective material properties and perform material response simulations on digitized 

microstructures of porous media. PuMA can generate artificial microstructures that mimic real materials and 

to compute morphological properties such as porosity, volume fraction, pore diameter, and specific surface 

area. Additional capabilities include the determination of effective thermal and electrical conductivity (both 

radiative and solid conduction — including the ability to simulate local anisotropy for the latter); effective 

diffusivity and tortuosity from the continuum to the rarefied regime; techniques to determine the local material 

orientation, as well as the mechanical properties (elasticity coefficient), and the permeability of a material. 

PuMA is available under the terms of the NASA Open Source Agreement (NOSA) and is a copyright of the 

United States Government as represented by the Administrator of the National Aeronautics and Space 

Administration. 

Stable releases of PuMA can be found on the official NASA GitHub repository at: 

https://github.com/nasa/puma. 

The latest development code can be found on the development GitLab repository at: 

https://gitlab.com/jcfergus/puma-dev. 

45.4 Netgen/NGSolve 

Netgen/NGSolve is a high-performance multi-physics finite element software. It is widely used to analyze 

models from solid mechanics, fluid dynamics, and electromagnetics. Users can freely download and examine 

the NGSolve source code from: https://github.com/NGSolve/ngsolve/releases. 

https://pytorch.org/
https://download.qt.io/official_releases/qt/
https://github.com/nasa/puma
https://gitlab.com/jcfergus/puma-dev
https://github.com/NGSolve/ngsolve/releases
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46 Learning Dragonfly 

You will find our latest user tutorials on Dragonfly Social at: https://dragonflysocial.comet.tech/c/user-

tutorials/. 

In addition, you can start discussions, chat, access material, post announcements, as well as upload and 

download deep models for the application on the Dragonfly Social online community platform. You can also 

take advantage of the course offerings listed below to further benefit from our training team's in-depth 

product knowledge. 

46.1 Dragonfly Workshops 

Our hands-on training workshops are a terrific way to get up and running quickly. Combining in-depth 

instruction with class exercises, our product specialists will quickly teach you how to use key Dragonfly 

features and functions to optimize your image visualization and analysis tasks. 

Contact sales.dragonfly@comet.tech for more information and availability. 

46.2 Online Training 

Get connected with an online training session and follow along with a Dragonfly product specialist as they 

demonstrate the features and benefits of Dragonfly and walk you through specialized modules. Web-based 

training, which can be adapted to individual needs and interests, offers an interactive approach that lets you 

practice new techniques on real world case studies. 

Contact sales.dragonfly@comet.tech for more information and availability. 

47 Requesting New Features 

Let us know if you have a suggestion for a new feature, or an idea for an improvement to an existing 

workflow. 

  

https://dragonflysocial.comet.tech/c/user-tutorials/
https://dragonflysocial.comet.tech/c/user-tutorials/
mailto:sales.dragonfly@comet.tech
mailto:sales.dragonfly@comet.tech
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48 Reporting Issues 

Dragonfly 3D World includes an integrated reporting module that lets you report any issue that results in a 

crash. Whenever you choose to send a report, try to include as much information as possible to help the 

support team to understand why the issue occurred. You can enter details about the issue, such as how to 

reproduce the problem, in the Send Report to Support Team dialog. 

 

Send Report to Support Team dialog 

You should note that you can also report an issue at any time by choosing Help > Report an Issue on the 

menu bar. For example, when an unknown error occurs, or an unexpected result is generated. 

 

Report an Issue dialog 
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If you decide to report an anomaly, please try to include the following information: 

• A description of the issue and when it first occurred. 

• The full error message and the steps required to reproduce the problem. 

• The installed version of Dragonfly 3D World. 

• The operating system of any affected machine. 

• If the problem affects a particular dataset or image, you may be asked to provide a copy of the dataset. 


